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INTRODUCTION TO THIS MANUAL
This manual is intended for undergraduate and graduate students learning

whelming and sometimes temperamental product. Figuring out why things

to use ArcView 9 in a classroom setting. It is meant to be a comple-

don’t work is key to getting ArcGIS to do what you want it to do and mini-

ment, rather than substitute, for ArcView software manuals, ESRI training

mizing your frustration. The section on trouble-shooting at the end of this

products, or the ArcView help options. It reflects the order and emphasis

manual is intended to help identify common problems and solutions.

of topics that I have found most helpful while teaching introductory GIS
classes. I expect that it will be particularly helpful to people new to GIS

This manual is intended to be shared. You do not need my permission to

who may be intimidated by conventional software manuals. It may also be

share this with a friend or even post it on a course website. Because I am

helpful as a resource to those who have completed a course in ArcView but

continually updating it, I always appreciate feedback, whether you found

don’t always remember how to perform particular tasks. This manual does

a typo or spelling mistake or want to suggest a better way of explaining

not try to be comprehensive, focusing instead on the basic tools and func-

particular concepts and techniques. The best way to succeed with GIS is

tions that users new to GIS should know how to use. Those who master

to make learning how to use it a collective process, so please join me in

these basic functions should have the skills to learn about additional tools,

making GIS work for us.

using the ArcView help menus, or just exploring additional menu options,

Amy Hillier
University of Pennsylvania
ahillier@design.upenn.edu

toolbards, and buttons.
Each section in the manual introduces a general group of functions in
ArcView, providing step by step instructions for using a set of tools with
screen captures and a video showing those steps through screen captures.
One of the most difficult parts of learning how to use GIS is matching what
you know you want to do in layman’s or conceptual terms to the specific
tool and technical language of ArcGIS. The table of contents provides an
overview of the tools and functions covered, but you may find it just as
helpful to use Adobe Acrobat’s “find” function.
The other challenge is trouble-shooting. ArcGIS products include an
enormous range of functionality which allows it to meet the needs of a wide
range of users. But this wide range also results in what can be an over-
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1| Introduction to arcgis
ArcGIS is a collection of software products created by Environmental

With the jump from ArcView 3.2 to ArcView 8, ESRI brought ArcView into its

Systems Research Institute (ESRI) that includes desktop, server, mobile,

ArcGIS system so that it uses the same structure as its more sophisticated

hosted, and online GIS products. This introduction provides an overview of all

GIS products. ArcView 3.x has similar functionality to ArcView 8, but the

of the products, but this manual focuses on the desktop applications, only.

products work in very different ways. That means that if you learned GIS
using ArcView 3.x, you will probably need to do some work to be able to
use ArcView 9. ArcView 9 adds some functionality to ArcView 8, but the two
versions work in a very similar way, so if you learned how to use ArcView 8,
you should have no trouble switching to ArcView 9.

ArcEditor
ArcEditor includes all the functionality of ArcView, adding the ability to edit
Map made by Shimrit Keddem

features in a multiuser geodatabase so that multiuser editing and versioning

Desktop GIS Products

are possible. ArcEditor also adds the ability to edit topologically integrated

The desktop GIS products allow users to integrate and edit data, create new

features in a geodatabase.

map layers, and author maps. ArcGIS desktop includes a series of scaleable
products. They are all based on the same architecture, but the more expen-

ArcInfo

sive products have more functionality. A matrix describing what functionality

ArcInfo is ESRI’s professional GIS software. It includes all of the functionality

is available for each product is available at http://www.esri.com/library/bro-

in ArcView and ArcEditor, adding some advanced geoprocessing and data

chures/pdfs/arcgis92-functionality-matrix.pdf.

conversion capabilities.

ArcView

ArcReader

ArcView is the desktop version of ArcGIS meant for a general (non-profes-

ArcReader is a free product for viewing maps. You can explore and query

sional) audience. It is the most popular desktop GIS software program, but it

map layers, but you cannot change symbology or create new data like you

is not the only one. Even though it is the “baby” desktop GIS product within

can in ArcView. ArcReader is a good way to share the maps you created in

the ESRI family of products, it is still over-kill for many simple GIS projects.

ArcView with people who don’t have access to the software.

Some people will call this “ArcGIS” rather than “ArcView.” They are one in the
same; ArcView is part of the ArcGIS collection, so it is a more specific way to
describe the software.

2
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Extensions for ArcGIS Desktop

Network Analyst

While the basic ArcGIS desktop products include an enormous amount of

Allows for network-based analysis such as routing, determining closest

functionality, extensions can also be purchased (some are free) that extend

facility, and service areas. Unlike simple representations of street networks

this functionality. Many of these are specific to particular industries or data

that can be manipulated without this extension, networks can store informa-

formats. The following are some of the more frequently used extensions.

tion about traffic flow, one-way streets, and travel time.

Spatial Analyst

Tracking Analyst

Allows for modeling and analysis with raster (cell-based) data. This includes

Makes it possible to animate point data representing events at discrete times

creating density surfaces and conducting map algebra.

and places. You can view events happing across time and space using the
“playback” feature.

3D Analyst
Includes ArcGlobe. Allows users to view visualize and analyze spatial data in

Streetmap

3D. This includes extruding polygons (such as parcels and building foot-

Makes possible geocoding of street addresses for the entire U.S. When using

prints) and draping surfaces (such as orthophotos) on elevation models. You

ArcGIS without Streetmap, street addresses generally need to be mapped

can also create video animations that simulate flying through your study area.

one county at a time.

Geostatistical Analyst

Business Analyst

This sophisticated tool allows users to analyze raster (cell-based) and point

Designed to support business decisions through a series of advanced tools

data using advanced statistical methods. Methods include Kriging and

and extensive collection of industry data.

inverse distance-weighting.

CommunityViz
Designed for visualizing and analyzing land-use decisions. This product is
distributed by Placeways rather than ESRI.

Model made by Shimrit Keddem

I n tr o d u c ti o n
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Scripts for ArcGIS Desktop

Mobile GIS Products

Extensions are simply bundles of scripts that are added together to ArcGIS.

These are useful for collecting data in the field. ArcPad includes many of the

Individual scripts can also be added without purchasing whole extensions.

same functions as ArcGIS destop products and can be installed on a pocket-

These are generally written in Visual Basic, Python, or Avenue (the old

PC. The size of the hardware and the display screen limits how much func-

programming language for ESRI) by users or ESRI staff members. A large

tionality can be included. ArcPad must be customized through programming.

collection are available for free at http://arcscripts.esri.com/.

ArcGIS products can also be used with global positioning systems (GPS),

Server GIS Products

which allow users to identify the longitude and latitude coordinates of particular locations in the field.

Desktop GIS is ideal for individual use (appropriate for classroom learning
and small-scale research projects), but distributing GIS data, maps, and
tools requires server GIS products. This is critical in a work setting as well as

Other GIS Products

when you wish to serve maps on the internet, which is increasingly common.

ESRI is the leading GIS software maker, sort of the Microsoft of GIS. Many
colleges and universities have site licenses for ESRI products, so GIS classes

ArcGIS Server

often use ESRI products. Other GIS products worth exploring include:

Used for data management, visualization, and spatial analysis in an “enterprise” (large-scale user) setting.

ArcGIS Explorer
Lightweight product that comes with ArcGIS Server; provides access to
GIS content; supports 2D and 3D maps and geoprocessing. This is ESRI’s
version of Google Earth.

ArcGIS Image Server
Needed for managing, processing, and distributing image data in a server
environment.

ArcIMS
Used to create applications that deliver maps and data via the Internet.

4

MapInfo
This family of products sold by CMC International can do much of what ESRI
products can do. MapInfo is much simpler than ArcView for working with
demographic data.

GRASS GIS
Geographic Resources Analysis Support System (GRASS) is free GIS
software that is increasingly popular among proponents of open-source
software.

Microstation
This is Bentley’s engineering design platform that incorporates GIS functionality through a number of different products.
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Introduction to ArcCatalog
ArcCatalog is designed to help you manage your spatial and non-spatial

the counties in Pennsylvania. The icon for “hospitals_pa.shp” shows that it is

data. Using ArcCatalog may seem awkward, particularly to people who are

made up of points, corresponding to the location of all the hospitals in Penn-

familiar with ArcView 3.x., but using ArcCatalog will help you to develop good

sylvania. The icon for “PA_major_roads.shp” shows that it is represented by

GIS habits, so it’s worth the effort. ArcCatalog is an ideal place to first view

lines, corresponding to each section of the state and federal highways in

your spatial data and supporting documentation.

Pennsylvania.

Launching ArcCatalog
ArcCatalog is a separate executable (.exe) file from ArcMap. You can launch
ArcCatalog from the Start Menu (go to All Programs, ArcGIS, then ArcCatalog) or from ArcView. If ArcView is open, click on the ArcCatalog button (looks
like a file cabinet) from the Standard toolbar.

The file named “philadelphia_pa_ne.tif” has a different sort of icon that indicates that it is raster data, made up of a regular grid of cells. This is an aerial

Recognizing File Types

photograph where each cell, or pixel, corresponds to 1 meter on the ground.

ArcCatalog will recognize files that are ready to be mapped using special

The income for the file named “cancer;020.dbf” indicates that it is a table, in

icons. Vector data are represented with icons that show whether they are

this case a dBase file. The file named “cancerp020.txt” icon shows that it is a

made up of points, lines, or polygons. In the screen capture to the right, the

text file. ArcView 9.1 and previous versions are capable of reading tables for-

files in the “Pennsylvania” folder named “cancer_pa.shp,” “hospitals_pa.shp”

matted as .dbf or comma-delimited text. In this case, the text file is a descrip-

and “PA_major_roads.shp” are all shapefiles, a format of vector data specific

tion of the map layer, “cancer_pa.shp” so it cannot be viewed by ArcView.

to ESRI (but often use-able in other GIS software). The “cancer_pa.shp”

Starting with version 9.2, ArcView can also read Excel (.xls) files.

layer icon indicates that it is made up of polygons, which happen to be all

I n tr o d u c ti o n
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Launching ArcCatalog

Creating Thumbnails

Shapefiles, the dominant format for vector data in ArcView, are made up of

For some files, including maps and layers created in ArcMap, ArcCatalog will

three or more separate files. Each of these will have the same name but a dif-

display a thumbnail image of your data when the “contents” tab is active. To

ferent extension. If you viewed them outside of ArcCatalog (in My Computer,

create thumbnails for shapefiles and images (you cannot create thumbnails

for example), you would see all of the files listed with extensions such as .dbf,

for tables), click the “preview” tab, highlight the shapefile name, and click on

.shp, .shx.

the “Create Thumbnail” button. Click on the “contents” tab in order to view
thumbnails.

2
1

In ArcCatalog these various files will appear as a single shapefile. In other
words, ArcCatalog allows you to view your data as ArcGIS sees it. This
makes ArcCatalog an ideal place for copying, pasting, or renaming shapefiles. If you try to do any of these
procedures using My Computer, you
will have to copy, paste, or rename

3

all of the pieces that make up the
shapefile. If you fail to copy, paste,
or rename even one, ArcGIS will no
longer recognize it as a single map
layer. The icon for the incomplete
layer may have a question mark,
indicating that the layer no longer has
integrity.

6
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Previewing Files

Switch the preview drop-down to “table” in order to view the attributes as-

By making the “preview” tab active, you can look more carefully at files.

sociated with your geographic features. Click on the “options” button to add

When the preview drop-down menu at the bottom of the window on the right

a new field or export the table. Right clicking on a column heading allows you

is set to “geography,” you can see how your data looks as a map. You will

to access a number of other functions such as sort, freeze/unfreeze column,

only be able to see the basic points, lines, or polygon outlines—you cannot

delete field, and statistics (the statistics option is only available for numeric

make thematic maps showing different data values across your map—but

fields). You can also access these functions in ArcMap.

this preview feature allows you to look quickly at your data. You can zoom in
and out and identify the basic attributes of the features in your map (these
tools will be described in detail in the next section, on ArcMap).

You can also view images here (ArcCatalog may ask you if you want to build
pyramids in order to display these more quickly, which is probably a good
idea).

I n tr o d u c ti o n
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Checking Properties

Viewing and Updating Metadata

Double click on the file name to bring up the shapefile or table properties (or

ArcCatalog also allows you to update and store metadata. Metadata are es-

by highlighting the file name and choosing “properties” from the File menu).

sentially data about your data, or the documentation. This includes informa-

With the fields tab active, you can identify the data format for each of the

tion about who created the data, how they created it and for what purpose,

columns in your table. These different data formats are described in detail

and whether there are restrictions on its use. Not all data you acquire will

in the section entitled “Calculating New Values,” but generally speaking, the

come with metadata, but it is important to get in the habit of checking and

way values are formatted in your table will dictate what kinds of functions and

updating metadata. Click on the “metadata” to view available information.

representations are possible. When you click on a column name, the length
of the field will appear below. From the XY Coordinate System tab, you can
see what datum and projection have been defined (if any). From the Indexes
tab, you can create attribute or spatial indexes in order to increase the speed
of searching, querying, and drawing data.

ArcCatalog offers several different stylesheets that define the types of information that can be included in the metadata documentation. The default is
ESRI’s stylesheet, but you can change this from the stylesheet dropdown
menu.
The buttons to the right of this dropdown menu allow you to (in order) edit
metadata, view metadata properties, create/update metadata, import, and
export metadata. Click on the “edit metadata” button in order to add or edit

8
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your metadata. You will probably not be able to fill in all of the requested
(“required”) fields, but fill in as much as you can. Most important are a description of the data (including the date, spatial extent, and geographic level),
limits on access (who can use the data?), contact information (when and
from whom did you acquire the data?), data values (is there a data dictionary that explains the meaning of values?), and data quality (are there known
problems?).

Other ArcCatalog Functions
These are the basic functions in ArcCatalog—organizing and previewing data
and working with metadata. ArcCatalog also has extensive search capabilities, making it possible to locate files based on name, location on your
computer, geographic location, and date. You can create new shapefiles in
ArcCatalog. This will be described in the section “Creating New Shapefiles.”

I n tr o d u c ti o n
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Introduction to ArcMap
ArcMap is where you create maps and access most of the ArcGIS functionality. You can add and edit data, query and symbolize map layers, and create
map layouts for printing.

Starting ArcMap
You can launch ArcMap in several ways. If you are in ArcCatalog, click on the
“Launch ArcMap” button. Alternatively, go to the start menu, then ArcGIS,
then ArcMap. You might also consider creating a desktop icon for ArcMap
if you plan to use it regularly. When ArcMap opens, you will be asked if you
want to open an empty map, use a template, or open an existing map. You
can prevent this dialog from displaying again by putting a check mark in the
“do not show this dialog again” box. Otherwise, choose “open an empty
map.”

If you created thumbnails for your map layers in ArcCatalog, you can also
click on the “Thumbnails” button on the far right to see the thumbnail image
of each map layer. Highlight the layers you want (hold the control key down
to select multiple layers), then click “Add.”

Adding Data
Unless you open an ArcView .mxd file that someone else created, you will
need to add data to get started. From the file menu, go to “Add data” or
click on the “Add data” button (yellow square with large black + sign) on the
Standard toolbar. Navigate to the folder where you have your map layers. The
default view will use the same icons that appear in ArcCatalog to represent
your layers.

10
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Connecting to Folder

Customizing the Interface

When you open ArcCatalog, a list of all the folders and sub-folders on your

ArcMap is made up of many different windows and (dock-able) toolbars

computer will be displayed on the left in the catalog tree. “Connect to folder”

that you can resize and move around, so don’t be surprised if ArcMap looks

allows you to make a direct connection to the place on your computer where

slightly different each time you open it. The window on the left that lists your

your GIS data are stored. From the file menu, go to “Connect Folder…”

map layers is the table of contents; the window on the right that shows your

or click on the “Connect to Folder” button (yellow arrow against a globe).

map is the map display. You can close the table of contents by clicking on

Navigate until you find the folder with

the “x.” To bring your table of contents back, go to the Window menu, then

your data and click “OK.” Your folder

Table of Contents. Resize it by holding your cursor over the right edge until

should now be listed under “Catalog”

your cursor changes to a two-headed arrow, then left-click and drag the edge

next to a icon. One note of caution:

to resize this window. To move one of your toolbars, left click on the end (top

You do not need to do this repeatedly.

or left), hold down, and move to a new location.

Once you have established a connection to your folder, you will not need to
do it again unless you change computers. If you create a new connection to the folder each time you use
ArcGIS, your path options will become
unmanageable.
You can delete paths using the “Disconnect from folder” button (globe with
yellow X).

I n tr o d u c ti o n
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You can move a toolbar by double-clicking on it

Working with the Table of Contents

to the left of the buttons (where there is a sort of

The table of contents has three tabs (at the

handle at the edge). You can “dock” it by moving

bottom): display, source, and selection. When the

it over any of the gray areas on the screen. To add

display tab is active, the table of contents will only

or remove a toolbar, go to the View menu, then

list data that can be drawn as a map layer, so you

“toolbars” or double-click on an empty gray part

will not see your tables listed. When the source

of the screen. Anything with a check mark next

tab is active, the table of contents shows the path

to it will be displayed. You can add new buttons

indicating where the data—including tables—are

to existing toolbars from the “customize” option.

stored. The selection tab allows you to choose

Click on the “commands” button to see your

which layers you want to be “selectable.” Most

options. One especially helpful button allows you

of the time, you will want the “display” tab to be

to zoom continuously. Scroll down to the category

active. Turn on and off a layer by checking and un-

on the left called “pan/zoom,” then left click on the

checking the box next to it. Layers are drawn in the

“Continuous Pan and Zoom” button on the right

map display in the order in which they are shown

and drag it to your tools toolbar (the toolbar with

in the table of contents. Map layers listed at the

the outline of a hand and an image of a globe in

top will draw on top. To move a layer, left click and

the middle) and release (see image on previous

hold the mouse button down, then move the layer.

page). You can also add new buttons and tools by

You can only re-order layers from the display tab.

importing scripts. That process is explained in a
later section called “Working with scripts.”

12
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Navigating a Map
There are several tools available for zooming in
and out of your map.
The continuous zoom tool gives you the

The fixed zoom in/fixed zoom out

The previous extent buttons allow you

greatest amount of control, but you have

tools give you the least control but also

to return to the extent you had before

to add this by customizing your toolbar

may keep you from zooming in or out too

zooming in or out. The next extent button

(see “Customizing the Interface” above).

much and losing your map. Each time

allows you to jump forward an extent

Click on the continuous zoom tool, then

you click, you will zoom in or out a fixed

(after you have used the previous extent

left click on your map, hold down the

amount.

button).

mouse button, and move your mouse
away from you to zoom in and toward you

The pan tool works like the continuous

to zoom out. If you right click and hold

zoom tool when you right click on it. Think

down, this becomes a tool for panning

of the pan tool as a sticky hand you set

(moving map around without changing the

down on a piece of paper. You use it to

extent).

move your map up, down, left or right
without changing the extent (the degree to

Using the non-continuous zoom tools,

which you are zoomed in or out).

you can click on your map to zoom in or
out at a fixed amount or to draw a box

The full extent button will zoom in or out

around the area that you want to see in

so that all of your active (checked) map

more or less detail. The new map will be

layers can be viewed. This is very helpful

drawn so that the area you drew the box

when you zoom in or out too much and

around is in the middle of the map display.

can’t see your map layers. You can also
zoom in to a single layer by right clicking
on the layer in the table of contents and
choosing “zoom to layer.”

I n tr o d u c ti o n
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Identifying Attributes of Features
The points, lines, and polygons that make up vector map layers are all map
features that have attributes stored in a table. This is part of what makes GIS
unique, that it can connect attributes of a location to that location. You can
access this information in several different ways. Using the identify (“i”) tool,
click on a map feature in the map display. An “identify results” box will display
all of the information known about that feature. Notice the layers dropdown
menu. The default in ArcMap is to display information only about the topmost layer. You can change this using the dropdown menu at the top of the
identify pop-up box.

14
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Showing Map Tips
Map tips are small text boxes that appear when you hold the cursor over
a map feature. You can only see one attribute at a time (unlike the identify
tool, which allows you to see all the attributes know for that map feature), but
using map tips is much simpler and allows you to get a quick idea of the attributes. To turn on map tips, double click on your shapefile name in the table
of contents and, from the Layer Properties, make the Display tab active. Put a
check mark in the “Display Map Tips” box. To change the primary data field,
make the Fields tab active and choose a field from the “primary display field”
dropdown menu.

I n tr o d u c ti o n
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Selecting Features
You can also use the select features tool to identify attributes, either by
clicking on a particular map feature or by drawing a box around the feature(s)
of interest. The selected features should become highlighted with a blue
outline. Right click on the map layer that contains the feature(s) that you
wish to investigate and go to “open attribute table.” This table includes all
the attributes of all the features in that layer. In order to view just the selected
feature(s), click on the “selected” button at the bottom of the table.

You can also highlight a feature on the map by clicking on a row in the table.
This way, you can find a specific place (such as Cyprus) on your map. The
“section” tab in the table of contents allows you to identify the layers you wish
to select. By default, all layers will be selectable.

You can change the selection color from “options…” in the Selection menu.
It is also possible to use different selection colors for each layer. Double click
on a map layer, or right click and go to “properties.” Choose the selection tab
and then select the last radio button, “Show selected features with this color.”
This will only change the selection color for this map layer.

16

H i l l ier

|

U si n g

A r c vie w

9 . 2

I n tr o d u c ti o n

17

Changing Map Symbols

For lines, you can choose from a variety of patterns, thicknesses, and colors.

ArcMap has many options for changing the way your data are displayed.

There are industry standards for things like highways, expressways, and

Some of the simplest options involve the choice of color, fill pattern, and

railroads.

shape (for point data). To make changes, click on the map symbol in the
table of contents. The symbol selector window that opens will look different depending upon the type of layer: point, line, or polygon. For points,
you can choose a different marker from the default (which is a circle with a
black outline). When you choose a new marker, the default size jumps from 4
point (quite small) to 18 point (quite large). You can find many more symbols
by clicking on “more symbols.” You can change the color, size, and angle
using the options on the right of the window. The “reset” button will undo any
changes you have made to the symbol since opening the symbol selector
window.

For polygons, you have choices about the fill pattern, fill color, and outline
color. The properties button will give you additional options (and often too
many options) but may be helpful in fine-tuning the crosshatch and ordered
stipple patterns.
You can also symbolize your layers based on different values for each map
feature. For example, you might use different size points to represent different cities around the world according to their population or use differ color
markers to represent different types of hospitals. These are considered
“thematic” maps and they will be discussed in the sections on displaying
points, lines, and polygons.
18
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Managing & Saving Data
Many of the frustrations of new GIS users relate to saving files. ArcGIS works
differently from most software, so if you do not take care in naming and
saving your files, you will not be able to find or open your work.

of the files used in your map document, that layer will be shown with a ! next
to it and will not draw when you open your map document. If you click on the
grayed out check mark beside the layer name, ArcMap will bring up a dialog
asking where you moved the file. Navigating to the file in its new location and
clicking “add” will solve the problem.

Saving ArcMap Documents
An ArcMap document is made up of all the map layers you have added
and all of the functions you have applied to them. It is best to only save an
ArcMap document when you have spent a significant amount of time.

Map Documents (.mxd)
When you open ArcMap, you are prompted to specify whether you wish to
open an existing map document or create a new one. Most of the time when
you are learning to use ArcView, you can create a new ArcMap document.
If you will need to return to your work once you start symbolizing your map
layers and designing a layout for printing, you will probably want to save an
ArcMap document. You do this by going to the File menu and choosing save.
This file will save all of the work you have done, including the list of data you
have added and the changes you have made to layer properties, symbology,
and the layout.

Using Relative Paths
One way to minimize problems when you move files that are part of an

The .mxd file does NOT save all of the data you included in your map.

ArcMap document is to use relative paths. If you specify that you want to

Instead, it includes information about the location of those files on your

use relative paths, ArcView will be able to find the pieces of your ArcMap

computer (or network, or Internet) and the formatting changes you made.

document as long as you keep the files used in the .mxd ArcMap document

This means that you cannot move the data files you’ve included in a map

in the same folder (so you can move that folder from one drive to another

document or just put your .mxd file on a thumb drive to open on a different

as long as you don’t move the individual shapefiles out of the folder). To set

computer without running into problems. It also means that map documents

relative paths, go to the File menu, choose “map properties” and click the

can be difficult to transfer from one computer to another. If you do move one

button “Data Source Options.” Choose the radio button, “Store relative path
names.”

I n tr o d u c ti o n
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ArcGIS can work with file names that are more than 8 characters, but really
long names can be difficult to work with. ArcGIS can also work with files that
have spaces in their name (such as Phila tracts.shp), but this can create
problems (especially with attribute names) so it is best to avoid by using
underscores (_).

Saving and Storing Files
The most important thing in storing files for ArcMap is to think through a
system BEFORE you start, so you can avoid moving files and disabling your
map documents and layers. Consider creating a new directory for each new

Saving Map Layers
In addition to saving the entire workspace with a map document, you
can save an individual map layer (.lyr). This file will store all the formatting
changes you have made to the layer. This is particularly helpful if you want to
use the same layer, with the same symbology, in another map document. As
with the .mxd file, the .lyr file only includes information about the formatting
and the path to the original data (generally a shapefile). Moving your original
data, or moving the .lyr file to another computer, will create problems.

mapping project. Keep all map documents, map layers, and tables in that
directory. Even though it will require more storage space, you may want to
keep separate copies of the same map layer, such as a streets layer, in each
project folder where you will be using it. As you work with ArcView, you will
also be creating new tables and shapefiles. Whenever ArcView is creating
a new file, you will be given an opportunity to give it a name and specify a
location with a dialogue box like this:

Naming Files
Naming your files in a clear and consistent manner will make working with
ArcMap much easier. You need to develop your own naming convention that
makes sense to you. You may create multiple versions of the same shapefile that are only slightly different, so your naming convention should reflect
those differences (in year, projection, attributes, geographic level, etc.). For
example:
Click on the folder icon to show ArcView exactly where you want the new file

20

Phila_tracts_2000_UTM.shp

Phila_bgroups_2000_stateplane.shp

and then give the file a new name. Otherwise you will end up with files called

Phila_tracts_1990_UTM.shp

NYC_tracts_1990_UTM.shp

“Export_Output.shp” and other unhelpful things like that.
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This layer does not have a .prj
file, so there is no projection information listed under the “source”
tab.

If there is no projection information, you can map the data to try to determine
its coordinate system. If the map units displayed in the gray bar below your
map are in degrees, seconds, and minutes, then you know the data are in a
geographic coordinate system. You may also recognize this because your
maps look distorted. For example, when Philadelphia map layers are in a
geographic coordinate system, the image appears to be sagging to the east.
Map layers in geographic coordinate systems are sometimes described
as “unprojected.” Map layers downloaded from the US Census Bureau are
generally in this format.

I n tr o d u c ti o n
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Data formats

Adding XY Data

ArcGIS can work with many different types of data, only some of which are
described in this section. ArcView 9.2 can work with more different data

Some tabular data include XY coordinates. For example, data might be collected usinga GPS device or a data vendor might sell the names and ad-

formats than previous versions of ArcGIS.

dresses of supermarkets and include XY coordinates for mapping. Convert-

Tabular data

geocoding and is explained elsewhere. You do not need to geocode if your

ing lists of addresses to points on a map usually involves a process called

Tabular data includes things like comma delimited or fixed width text files,
Excel worksheets, ACCESS files, and dbase files. This is where you store

table already includes XY coordinates. Simply add the table to ArcMap, right
click on the table, and go to “Display XY Data…”

attribute data, which includes any information you have about a location.

From the Display XY Data window, choose

Tabular data generally do not include location data, so they cannot be

the field that contains the X (longitude) and Y

mapped until they are linked to a map layer. Unlike previous versions,

(latitude) coordinates. If you know the projection

ArcView 9.3 can work with

used to collect or create the data, click on the Edit

Excel files. You must specify

button.

which worksheet you wish

Geographic data

to add. When you add data,

The tabular data you use in ArcGIS can be used

double-click on the name of

in other programs like Excel, SPSS, SAS, and

the .xls file to see the names

STATA, but the geographic data you use can only

of the worsheets. Highlight a

be used in GIS programs. Geographic data store

worksheet and click “add.”

information about location so that they can be
represented as map layers. Geographic data can
be categorized as vector or raster. This manual
deals primarily with vector data.

22
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Shapefiles

files with defined projections. The shapefile stores information about the shape of the

Shapefiles are the most common format for vector data in ArcView. Vector

map features, describing them in the “shape” field of the attribute table as point, line,

data use points, lines, and polygons to represent map features. Vector GIS

or polygon. It also stores information about the real world location of each vertex that

is excellent for representing discrete objects, such as parcels, streets, and

makes up the map features. Using this information, ArcView can calculate area and

administrative boundaries. Vector GIS is not as good for representing things

perimeter for polygon features.

that vary continuously over space, such as temperature and elevation.
ESRI created the shapefile format in order to represent vector GIS data in
a simpler format than their coverage format used in ArcInfo. As with other
formats of geographic data, shapefiles link information about the location
and shape of the map features to their attributes. Other GIS programs will
allow you to use shapefiles, but geographic files from other GIS programs
must be converted to shapefiles before ArcView can read them. Shapefiles
are made up of three or more files that need to be stored in the same directory in order for ArcView to recognize them as shapefiles. When you look at

Topology
On of the biggest complaints about the shapefile format is that it does
not contain information about topology. Topologic formats (like coverages
used in ArcInfo) contain detailed information about the relationships among
features in the same map layer. This allows for a variety of operations to
ensure the integrity of lines and polygons and to carefully edit and create
new geographic features. In creating the shapefile format, ESRI intentionally
created something that is simpler than existing topologic formats for desktop
(rather than professional) GIS users.

your shapefiles through ArcMap or ArcCatalog, you will only see one file, but
if you look at them directly on your hard drive or thumb drive, you will see
multiple files with the following extensions:
.shp - the file that stores the feature geometry (point, line, or polygon)
.shx - the file that stores the index of the feature geometry
.dbf - the dBASE file that stores the attribute information of features. When a shapefile is
added as a theme to a view, this file is displayed as a feature
table.
.sbn and .sbx - the files that store the spatial index of the features. These two files may
not exist until you perform theme on theme selection, spatial join, or create an index on a
theme’s shape field.
.pjr – the file that stores information about the projection. This will only exist for shape

I n tr o d u c ti o n
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Images
ArcGIS allows you to import and export many different types of images. The
images you import may be scanned paper maps, aerial photos, or other
pictures or photos that you “hot link” to your map features. ArcMap can
import a wide range of file types. You can also export finished maps in
ArcMap in a number of formats: EMP, BMP, EPS, TIFF, PDF, JPEG, CGM,
JPEG, PCX, and PNG. Images are like tables in that they may contain information about a particular location, but they do not store location information

Raster map layers
Raster data use grids made up of regular cells, or pixels, to represent
spatially continuous data. They look like regular images, but each pixel is
assigned real world coordinates and an attribute value (such as precipitation
level or elevation), so the data can be mapped. The user defines the cell size,
allowing for very fine or course raster surfaces. Even when the cell size is very
small, you can see the individual square cells when you zoom in.
You can view raster

so they cannot be mapped. When you add a large image to ArcMap, you
will often be prompted

layers in ArcMap without

to decide whether

any additional exten-

you wish to “build

sions, but you need the

pyramids.” Generally

Spatial Analyst exten-

you want to say “yes”

sion to analyze or create

because this will make

new raster layers. When

it easier to work with

raster layers have the

the image in ArcMap.

same size cells, their
values can be added,
subtracted, multiplied,

You will also receive a

divided and queried using map algebra (a system developed by Dana

message that ArcMap

Tomlin). You can add raster data to ArcMap just as you do vector data, using

is unable to draw the

the “add data.” Be sure to highlight the layer you want, then click “add” (if

image as a map layer

you double click, you will see the individual bands that make up your raster

because it is missing

lay). ArcMap saves raster layers in its GRID format. ArcCatalog recognizes

information about location. So why would you add an image to ArcMap in the

GRIDs and other image formats (including BMP, JPEG, TIFF) as raster layers.

first place? Because images like aerial photographs and scanned historical
maps can be transformed into map layers through a process called georectifying.

24
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Geodatabases
ESRI has moved toward a new geographic data model called a geodatabase
that used Microsoft ACCESS files to store multiple tables, shapefiles, and
raster images. Geodatabases are more complicated than shapefiles and
a license for ArcEditor (not just ArcView) is required to edit geodatabases.
Shapefiles are generally sufficient for individual projects, but geodatabases
are more appropriate for work environments where multiple people are accessing information or when advanced editing is required.

I n tr o d u c ti o n
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2 | Spatial Data
Working with Projections

click on the “…” button to the right of “Spatial Reference.” You can access

Projections manage the distortion that is inevitable when a spherical (okay,

This layer has a .prj file, so

ellipsoid) earth is viewed as a flat map. All projection systems distort geography in some way—either by distorting area, shape, distance, direction,
or scale. There are dozens of different projection systems in use because

the metadata through ArcCatalog.

there is projection information
listed under the “source” tab.

different systems work best in different parts of the world and, even within
the same parts of the world, GIS users have different priorities and needs.
When you are looking at a relatively small area, such as a single city, there is
relatively little distortion because the curve of the earth is slight. But knowing
and setting projections properly is also important for getting your may layers
to draw together, distance units to make sense, and some of ArcView’s tools
to work.

Recognizing the Coordinate System
Map layers can be drawn according to a geographic coordinate system
(unprojected) or projected coordinate system. Geographic coordinate
systems indicate location using longitude and latitude based on a sphere
(or spheroid) while projected coordinate systems use X and Y based on a
plane. As long as computer screens and printed maps are flat, projected
coordinate systems will be more appropriate for working with GIS data. You
may not always know the coordinate system used, particularly if you inherit
data or download it from the Internet. If you are lucky, the map layer will
include a .proj file which contains information about the coordinate system or
the metadata will explain. You can look at the information in the .prj file—the
detailed spatial reference information—by clicking on the “general” tab of
the layer properties from ArcMap. Alternatively, you can click on the “fields”
tab of the layer properties from ArcCatalog, click inside the “shape” field and
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Working with “Unprojected” Layers
In most cases, you will want to convert unprojected map layers—those with a
geographic coordinate system—to projected map layers. There are two steps
involved in this process. First, you must create a .proj file “defining” the map
layer as unprojected; then you can “project” the map layer using the projection of your choice. You can access the tools for doing this by clicking on the
ArcToolbox icon inside ArcMap. Click on “data management tools” and then
“projections and transformations.”

Defining projections
Defining a projection registers your map layer with a known projection.
It involves reporting to ArcView the nature of the data that you have, not
changing that data. To “define” the coordinate system for your unprojected
map layer, click on the “Define Projection” wizard. First you will be asked to
choose a data layer. If you added the relevant map layer to ArcMap, you will
be able to find it in the dropdown menu. Otherwise you will need to click on
the folder icon to locate your map layer. Then you can choose the coordinate system using the button. Click the “select” button on the Spatial Reference Properties. In most cases, you can choose “Geographic Coordinate
Systems,” “North America,” and “NAD 1983 Datum,” then click “okay.” You
should not notice a difference in how the map layer is drawn as a result of
defining the coordinate
system. But as a result of
defining it, there is now a
.proj file associated with
your map layer and you can
look at the detailed spatial
reference information.
Before you define a layer
as unprojected, ArcView
will refer to it as “assumed
geographic.”
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Projecting shapefiles
Projecting a shapefile changes the projection system. You can only do this
if you have defined (registered) the existing projection. You can project map
layers that are unprojected (geographic coordinate system) or change the
projection on layers that already have a projection system. In order to project
the map layer, click on the “Project” wizard. If you are projecting a shapefile,
use the “Project” wizard listed under “Features.” If you are projecting a raster
image, use the “project” wizard listed under “raster.”
As with the “define” wizard,
you will be asked to specify
the map layer. Next, because
you will be changing the
original layer, you are asked
to name the new layer that
will be created. By default,
ArcView will add “_Project” to
the original name. You may wish to give your layer a different name. Click

Working with Projected Map Layers

on the button to the right of “Output Coordinate System” to choose your

carry a .proj file so you won’t know the projection. The best thing to do in this

projection. Click on the “select” button on the Spatial Reference Properties,
then choose “Projected Coordinate Systems.” Now you need to choose your
projection. For relatively small areas like Philadelphia, the differences in projection systems (the distortion in shape, area, distance, direction, and scale)
are minimal. You are best off choosing whatever projection system is most
commonly used. In Philadelphia, that is State Plane 1983 (feet) Pennsylvania
South. For the Philadelphia MSA, consider UTM zone 18N. After making your
selection, click “okay.” ArcView will indicate that there is a “Datum conflict
between map and output.” In order to map your newly projected layer, create
a new ArcMap document and add the new (projected) layer. You should
notice a change in the coordinates that show in the bottom right of the map.
28

Sometimes the map layers you acquire will already be projected but won’t
situation is to look at the original source for information about the projection
system, either on a website, in metadata that came with the file, or by calling
the person who created the data. If these approaches all fail to reveal the
projection, map the data in order to guess the projection. You may recognize
the projection by the units showing in the gray bar below the map. If they
are not in longitude and latitude, they are probably projected. As you work
with a particular projection system, you will come to recognize the map units
and range of coordinate values. For example, State Plane coordinates for
Philadelphia are generally in feet and look like 2691607.78, 246268.98. UTM
coordinates will be in meters and look like 486850.72, 4430095.19.
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When you add a shapefile to ArcMap that the software recognizes as being

map document. All of the map layers listed under the Layers icon in your

projected but has no .proj file, ArcMap will usually warn you that spatial refer-

table of contents are in the same data frame (you can have multiple data

ence information is missing.

frames in the same map document, although in most cases you will probably
have just one). Right click on the word “Layer,” go to Properties, and make
the Coordinate System tab active. From here, you can choose a coordinate
system (State Plane 1983 is in the “Projected Coordinate Systems” folder
inside the “Predefined” folder).

Data that are projected but missing spatial reference information will look
fine when they are drawn, but you may not be able to use ArcView’s “on the
fly” projection capabilities, measurement tools, spatial join, or geoprocessing functions. If you know the projection, you can use the “Define Projection”
wizard in the ArcToolbox. You will need to select the projection from the “Projected Coordinate Systems.” If a map layer is already projected AND defined,
you can change the projection using the same tool. You will need to add the
reprojected map layer to a new ArcMap document in order to see the results.

Defining Projection for Data Frame
Ideally, you will know and will specify the projection of each of your map
layers. Alternatively, you can set the projection for your Data Frame for your
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Add map layer to new ArcMap document.

A layer is defined if ArcView knows whether
and how it is projected. Look in the “source”
tab in the layer properties to see if a coordinate
system (either geographic or projected)is listed.
If it does not include the word “assumed” or
“undefined” it is defined. There will also be a
.prj file with the same name as the map layer in
the same directory as the other pieces of the
shapefile if the layer is defined.

Is the layer defined?

If a map layer is defined
incorrectly, you will likely get a
message about “inconsistent”
spatial reference information.
Also, look for inconsistency
between the coordinates on the
bottom right of the map and
the defined coordinate system
in the source tab.

Yes, it is defined.
Is it defined correctly?

Yes, defined correctly.
Is it projected?

YES

Do nothing unless
you want to change
the projection.
Change the
projection using the
“project” wizard.

As long as the layer is defined, it doesn’t
matter what projection system is used.
The map layers should draw together. If
you are building a project-specific GIS
with many layers, you may want to use
the same projection for all of them.

30

A layer is not defined if the “source” tab in the
layer properties says “undefined” or “assumed.”
Also look for pop-up message when you add a
layer to ArcMap that says spatial reference
information is missing. The coordinates on the
bottom right of your map may also have
“unknown” units.

No, not defined correctly

Re-define the
map layer using
the “define”
wizard

NO

Determine the
projection you want
and set it using the
“project” wizard.

Choose a map projection that (a) reflects
local standdards; (b) that is designed for
that geographic area; (c) that matches
your other map layers.

No, it is NOT defined.
Is it projected?

Yes, it is projected

No, it is not projected

Make your best guess of the projection
and define the map layer using the
“define” wizard. Be sure to choose
something from the Projected
Coordinates folder.

The coordinates in the bottom right of the map
are your best clue as to the projection.
You will know that you chose the right
projection (or close enough) if you can get your
layers to draw together. If your map layers do
not draw together, try another projection.

H i l l ier

Your data are probably not
projected if your map is sagging
and/or has lat-long
coordinates. Also, look for
“GCS assumed” in the source
tab.

Define the layer as
geographic NAD
1983 using the
“define” wizard.
Then determine the
projection you want
and set it using the
“project” wizard.

Choose a map projection that (a) reflects
local standdards; (b) that is designed for
that geographic area; (c) that matches
your other map layers.
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Troubleshooting with Projections
If you are unable to draw your map layers together or if your distance units
do not make sense, you are likely experiencing a problem with projections.
It is easy to get confused while using the “Define Projection” and “Project”
wizards, and frequently the more you try to fix the problem, the more mixed
up your projections get. Try starting over with your original files (be sure to
keep a copy of the originals before messing around with the projection).
If you are not able to figure out the problem, you may want to show your
shapefiles to someone with more GIS experience.

Georectifying Images
Georefectifying allows you to convert a paper map into a GIS map layer. Essentially, the process assigns X and Y coordinates to points on your digital
map image, shifting, rotating, and scaling your map so that you can view it
as a map layer along with your shapefiles. The simplest form of this, using
onscreen tools, is explained below.

Create a raster image
Scan your paper map. The higher resolution, the better. ArcMap can handle
pretty big files, and it can work with lots of file types (.jpg, .tif, .bmp). If you
have a choice, go with .tif and 300 dpi or better.

Add reference layers (shapefiles)
Before you add your scanned image, add a shapefile that covers the same
geographic area. This might be a street centerline file, city boundaries,
or something similar. Be sure that you can identify a few places on your
scanned maps on this shapefile (such as a landmark or street intersection).
Otherwise, you will not be able to use on-screen georectifying.
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Add map image

In order to start georectify-

Add your image to ArcMap just as you would a shapefile or table, using the

ing, you’ll need to switch

button or from the file menu, choose “add layer.” Depending upon the size

back so that you can see

of your image, a dialogue box will ask you if you’d like to add pyramids.

your shapefile, rather than

Click “OK.” Don’t worry if you get a warning message that your image lacks

your image. Right click on

projection information. At this point, your scanned map is just an image, so

the shapefile and choose

it shouldn’t contain any spatial information. The name of your image should

“zoom to layer.” From

now appear in the table of contents, but you will not see your image drawn

the view menu, choose

with your shapefile. At this point, your image is in “pixel space” since there is

toolbars, then georefer-

no coordinate information. To see your image, right click on the name in the

ence.

table of contents and choose “zoom to layer.”
From the georeferencing menu, choose “fit to display.” Now your reference
layer(s) should draw on top of your map image in the view map window. If
your scanned map is upside down, use the “Flip or Rotate” tools.

32

H i l l ier

|

U si n g

A r c vie w

9 . 2

Add control points

After

Click the “add control points” button. Create your first control point on your
image by clicking once on your scanned map, then click on the shapefile
in the corresponding spot. Your image should shift closer to your shapefile.
If it gets further away, you probably reversed the order. Be sure to click on
your scanned map first, then the shapefile. You may find it helpful to use the
magnifier window (from the window menu, choose “magnifier”) so that you
can see your map details without zooming in. Continue to add control points.
After doing this a few times, your image should be more or less lined up with
your shapefile. Continue to add control points as long as doing so improves
the alignment.

Before
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In most situations, your map image will not line up perfectly with the shapefile

Transformations

and you should not expect it to. The original map you scanned may have

If you have six or more control points, you can perform a second order; if you

been created using a different projection system or included distortions and

have twelve or more control points, you can perform a third order transforma-

the map may have been further distorted or damaged over time. If the image

tion. But be sure to look at how these transformations distort your map. You

gets further and further away from the shapefile, however, try starting over.

may be better off with the first-order transformation.

From the georeferencing menu on the georeferencing toolbar, go to “delete
control points” and “reset transformation,” then choose “fit to display” again.

Rectify Image

You can also delete a single control point using the “view links” button. The

In order to permanently save the transformation, choose “rectify” from the

control points are listed in the order that you created them, so the most

georeferencing menu. ArcMap will create a new image (rather than changing

recent control point will be listed last. To delete one, hightlight it and click the

your original data). Check the ArcMap Desktop Help if you want information

delete (X) button.

about choosing a resampling type. ArcView will not automatically add your
new rectified map in, so go to “add data” and take a look at your new rectified map before you delete your image. If the resolution of the rectified map
is much worse than your original scanned map, try rectifying it again and
specifying a smaller cell size.
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3 | Making Maps
Symbolizing Points
The real strength of a GIS is in allowing you to use different symbols to represent different values, linking your attribute data to your spatial data. ArcMap
offers a wide range of colors and symbols for representing your point data.
Keep in mind that just because there are near infinite combinations that the
simplest symbols (such as block dots) may be the most effective.

Single Symbol
The default in ArcMap is to represent all points with the same size, shape,
and color symbol. This is how ArcMap will display your point shapefiles when
they are first added to a map document or when you create them through
geocoding or adding XY data. Open the layer properties (double click on the
shapefile name or right click and go to “Properties,”) and click on the “Symbology” tab. In the box on the left side, “single symbol” will be highlighted.
You can change the size, shape, or color of the symbol by clicking on it,
but as long as “Single symbol” is selected, all of your points will appear the
same.
To view additional pallete, click

Changing the symbol
ArcView has numerous palettes of symbols used in various industries, such
as conservation and policing. These specialized symbols are effective when
used carefully with an audience that will recognize them as industry stan-

on the “properties” button. The
“civic” palette contains a number
of choices for schools.

dards. The symbols included in the default palette may not be ideal for your
map. For example, the symbol for a school bears little resemblance to a large
urban school.

3 |
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In most cases, however, you are
better off sticking with the default
symbols. You don’t need the
symbol of a needle to represent
drug crimes. Resist the temptation
to be too literal. These are, after
all, symbols and you will be able to
describe the symbol in the legend.

Categories
Categorical variables classify data into unique categories so that each observation (event, person, building, etc.) fits in only one category. For example,
a hospital might be managed by a non-profit, church, federal government,
state government, or for-profit entitity. The unique values option listed under
“categories” in the symbology tab allows you to use a different symbol for
each of the points in a shapefile based on a categorical variable. This can
work well for small files (10 or fewer points) but can quickly be overwhelming
for larger files. Choose the field with the values you wish to use to represent
your points, then click the “Add All Values” button. ArcMap will list a symbol
for “<all other values>” that you can remove by taking away the check mark.

Choose colors that communicate that these are separate categories. Don’t
use a graduated color ramp with light to dark shades of the same color.
This implies that one category is more or less than another when, in reality,
they are just different. In addition to different colors, use different sizes and
symbols.

You can change the individual symbols by clicking on them. You can make
changes to all of the symbols, or selected symbols (hold down the shift key

Quantities

to select two or more) by right clicking. To remove a value, right click on it

Categorical variables correspond to categories and are generally represent-

and choose “Remove Value(s).” Use the black arrows on the far right to move

ed using text variables (or numbers used as codes for individual categories).

values up and down (the order here will be the order your values appear in

Quantities, such as the population of a city or air emissions, are continuous

the legend on your map).

and must be presented with numbers. Graduated symbols and proportional
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symbols are the best choices to show different quantitative values for points.

Proportional symbols are similar to graduated symbols, but the size of the

Graduated symbols allow you to have different size symbols to represent

symbol reflects the relative size of the quantity. For example, a hospital that

different attribute values. With the symbology tab active, click on “Quantities”

has 100 beds would be represented with a symbol that is twice as large as a

and then “Graduated symbols.” From the “Values:” dropdown menu, select

hospital with 50 beds. Proportional symbols are preferable except in situa-

the field with the values you wish to use. The default is five categories, so five

tions where the symbols become too large and obscure other points.

value ranges represented by different size dots should appear below. Use the
“classes” dropdown menu to change the number of categories. There are
many ways to break up value ranges into categories. The default is “Natural
Breaks,” which uses Jenks optimization to identify grouping of values that
minimize within group differences. To change this, click on the “Classify”
button and use the Method dropdown menu to choose a different classification system. You can also adjust the cutoff points by moving the blue vertical
lines in the histogram below that show the frequency of values. Alternatively,
you can change values manually on the previous screen by clicking on them
(you will only be able to change the ending value).
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Symbolizing Polygons (Area Data)
The options for symbolizing polygons (such as census tracts) are basically
the same as the options for symbolizing points, but the attribute data that you
have for polygons will often be different so you will utilize the same options in
different ways.

Graduated Color
You can use different colors—or different shades of the same color—to
represent different continuous variables (such as household income or
median age) to create choropleth maps. From “Layer Properties,” click on
the symbology tab. On the left side of the screen, click on “Quantities” and
“Graduated Color.” Choose the field with the values you wish to use. Use
the “Classes” dropdown menu and the options in “Classify” to change the
number of categories or method for breaking values into categories.
Choropleth maps are generally better at representing rates (such as percent
registered voters) rather than counts (such as total voters). You can transform
count data into rate data using the “Normalization” dropdown menu in the
“graduate color” option. In order to use this appropriately, you will need to
select the variable from your attribute table that serves as an appropriate denominator. For example, in order to show the percent of households receiving
public assistance, normalize the total number of households receiving public
assistance by the total number of households. Do not use the “<PERCENT
OF TOTAL>” option to create a rate.
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Graduated color works best when you use the same shade of a single color,

Customizing a color ramp

with lighter shades representing lower values and darker shades represent-

You can create your own color ramp if you are not happy with any of the

ing higher values, or intuitive color schemes such as yellow to orange to red

default choices. To do so, go to the “Tools” menu and click on the folder

or yellow to green to blue. But keep in mind that it may be impossible to dis-

called “ESRI.Styles,” then “Style Manager.” Right click the Color Ramps

tinguish between more than four or five shades of the same color, depend-

folder on the right, choose “new,” and elect Algorithmic Color Ramp. Select

ing upon the quality of your printer. To fine tune colors, go to “more colors”

a color for Color 1 (the beginning of the color ramp), then a second color for

when choosing a color from the symbol selector. Here you can play with the

Color 2. Give your new color ramp a name and close the Type the name of

hue(H), saturation(S), and value(V).

the new color in the Contents window. Your new color ramps should appear

1

2

at the top of the dropdown list of color ramps in the Symbology tab.

3
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You can also create your own color ramp by manually picking colors in the
Symobology tab. To make these a color ramp that you can then choose for
other layers, highlight the middle (other than first and last colors) and choose
“ramp colors.”

You can find a more detailed explanation of algorithmic, random, multi-part,
and preset color ramps that can be created in ArcGIS in the help section.
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Fill Patterns
You can use different patterns in addition to, or instead of, using different
colors to represent different values. Patterns are particularly helpful when
you are restricted to printing maps in black and white. Choose “Graduated
Colors” from the Symbology tab and select the field with the values you want
to display. Set the number of classes and the method of classification, so that
you are happy with the value ranges. Then click on the symbols and change
the fill using the symbol selector. Click on the Properties button to fine-tune
the fill pattern. This may involve changing the background from white to “No
color” so you can draw a layer symbolized with a fill pattern on top of a layer
with solid colors in order to see the relationship between two different attributes.
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Dot Density
Dot density maps use randomly placed dots within polygons to represent
different values for aggregate data. They provide an alternative to choropleth
maps for count data. If you use this option, be sure to remember—and carefully communicate on your map—that the points do not represent precise
locations, as they do in a point layer. Failing to do so may generate confusion and concern about data confidentiality. One major limitation of this type
of map is that the dots may be distributed across parts of the polygon that
don’t make sense. For example, if you use dot density to show the number
of foreign-born in a map of counties, the dots might appear in non-residential
areas. You can avoid this problem by selecting a “mask” (such as parks and
industrial areas) where dots should not be placed.
To create a dot density map, open the Layer Properties and make the Symbology tab active. Click on “Quantities” and “dot density.” From “Field Selection,” choose the field you wish to use as the basis for the map. Counts (such
as the total number of households on public assistance) are appropriate for
dot density maps, but averages, medians, and rates are not. Choose your
dot size, or keep the default (which is advisable, at least to start). The “Min,”
“Mean,” and “Max” boxes will give you a preview of how your map will look.
The “Dot Value” indicates how many units each dot represents. Change this
as needed to create dot densities that have enough dots to show variation
but not so many that they are all on top of each other. You can change the
color of the dot by clicking on it under “Symbol” in the top right part of the
screen. Checking “maintain density” will ensure that the dot density looks the
same as you zoom in and out (by making the dots bigger and smaller).
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Pie Charts
Charts are good for showing multiple values and the relationship between
values on different variables. Pie charts are especially good for showing
proportions. For example, individual pie pieces can be used to show the
breakdown in race for the population in a census tract. For the pies to work,
you must be able to put every person into a racial group, or you must use
an “other” category. Pies contain a lot of information, so it can be difficult to
display them clearly. To create pie charts, click on “Charts” and “Pie” from the
Symbology tab. Holding down the shift key, select the fields that you want to
include. Make sure that together, they add up to 100 percent (you may need
to create and calculate a new “other” field in your attribute table before using
charts). Click on the “Background” button to change the color or fill (“Hollow”
or white backgrounds might be best, so that you don’t have too many colors
in your map). If you check “Prevent Chart Overlap,” ArcView will use “leader
lines” to indicate where the pie charts belong if there is no room to display
them within the map feature. Click on the Properties button to make adjustments to the look of the pie (3D, rotation, height).
Click on the Size button if you want to have different size pie charts depending upon the total (such as total population). If you choose to “Vary size using
a field,” you may need to exclude records with a zero value. To do this, click
on the Exclusion button and, using the appropriate field name, create an
expression such as “[TotalPop] = 0.” You may need to play with the minimum
size on the previous screen to make the maximum size pie chart a reasonable size.
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Bar/Column Charts
Bar charts can be used to compare values on two or more variables that
do not represent proportions (they don’t have to be subsets that add to 100
percent). For example, the map on the right compares the total population
by block group to the total number of households. To switch from column
(vertical) to bar (horizontal) charts, go to Properties on the Symbology tab of
Layer Properties and switch the radio button under “Orientation.”

Stacked Charts
Stacked charts can be used to compare values on two or more variables
(such as race) that are subsets of a larger variable (such as total population)
when you don’t know, or don’t want to display, all of the subsets. You have
many of the same options for formatting (size, color) that you have with the
other types of charts.
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Labeling Features
Labeling features can be frustrating and tedious, but labeling features well is
important to making your maps readable and communicating their meaning,
so it’s worth the effort to learn.

Using Text Boxes to Label Features
You can place text on a map in order to label map features. The text tools
require that you type the feature name yourself while the label tools take advantage of feature names stored in the attribute table. The text tool can work
well if you only have a few map features to label. Click on the button marked
“A” on the drawing toolbar.
The callout text tool works similarly, except that it allows you to place your
text away from the map feature while still indicating what is being labeled.
Click on the tool and then click on your map feature. Before letting go, you
can move the cursor to where you would like the label to be. Type your label.
Using the “Select Items” tool, you can move the text box so that it is closer or
further from the map feature. The yellow background with black text may not
be what you want (actually, it probably won’t be what you want).

This will bring up seven different text and label options. Click on the “A.”
Click on your map where you want your text to appear and type your label
in the text box. Hit the enter key, or click your cursor outside the text box
to complete. You can move the text around using the “Select Elements”
tool. Double clicking on the text will bring up the Properties, where you can
change the size and font (using the “Change Symbol” button).
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From the “text properties” dialogue box, choose “change symbol,” then

Manually Placing Labels

“properties,” then the “advanced text” tab, then the “properties” button below

Using the label tools in ArcMap, rather than the text tools, allows you to use

“text background”. From here, you can choose between two different style

the values in a layer’s attribute table for your labels (in other words, you don’t

callouts. Click on the “symbol” button to change the background color.

have to type the label out as you do with the text tools). By manually placing
labels, you also avoid having your labels act as a group (which happens with
auto labeling), so it’s easier to move or edit a single label.
Before you can use the label tools in ArcMap, you need to indicate which
field in the attribute table of your map layer you want to use as the basis for
labels. From Layer Properties, click on the “Labels” tab. Leave the “label
features in this layer” box empty (clicking this creates auto labels). Choose
the appropriate field from the Label Field dropdown menu. Click on symbol
to change the size, style, or font for your labels. (Guessing what size to make

A third option is the spline text tool. This allows you to write text along a

your labels is difficult and you will probably need to make small adjustments

curved line. This works well for labeling rivers and curvy roads. Click on the
spline tool, then click on the starting point for your label. Continue to click
along the curve (you don’t need to make many clicks) and double click to
finish. Then type your label in the text box. You will probably need to try this
several times to get a label with which you are happy (just click on the label
with the “Select Elements” tool and hit the “delete” key to delete a label).
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after seeing what works). Using the “Placement Properties” button, you can

Auto Labeling

instruct ArcView what to do about duplicate labels. The “Scale Range” allows

You may find it easier to automatically label all of your features. This saves

you to instruct ArcView when to draw or not draw labels, depending on the

time if you are happy with the way the labels look, but it offers you much

extent. In order to do this, you need to know the exact scales you’ll be using

less control over the label placement. When you automatically label features,

(so you probably just want to leave this alone). The “Label Styles” button

the labels are “dynamic” so changes you make to one (moving it, changing

gives you access to some fancier label options. The highway labels are par-

the style) are made to all. To label your map features automatically, go to

ticularly helpful. Now you can use the label tool to manually label your map

Layer Properties, click on the Label tab, and put a check mark in the “Label

features.

Features in this layer” box. You can also label automatically by right clicking
a map layer and going to “Label Features.” To delete your labels, you’ll need
Close the “Layer Properties” dialog box. Click on the

to return to the Label Properties box and remove the check mark from “Label

button marked “A” on the drawing toolbar and choose

Features in this layer” box or right click and go to “Label Features.” You can

the “Label” tool.

select “In the map” as a place to store the annotation.

Converting Labels to Annotation
One solution to the problem that auto labeling presents with groups of labels
The “Labeling Options” window will

is to convert them to annotation. This allows them to function as individual

open. Decide if you want ArcView to

text boxes so you can

decide the best label position or if you

change the style for a

want to determine that yourself. The

single label. To do this, right

“Choose a style” radio button gives you

click on your map layer

access to those fancier labels again.

after labeling it and go to

You can move these labels (using the

“Convert Labels to Annota-

“Select Elements” tool) and change

tion.”

their size and style (double click to
bring up Properties). You can delete a
label by clicking on it and pressing the
delete key.
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Using a Halo with Labels
Sometimes labels are difficult to see on top of a map that includes many
different shades and colors. By creating a halo around the label, it will stand
out. To create a halo, double-click on the label text to bring up the “Properties” dialog box, then click “change symbol,” “properties,” and select the
“mask” tab. Choose the “halo” radio button. You can select a halo color other
than white and adjust the thickness (1.5 point may be enough).
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Designing Map Layouts
Displaying data so that you can analyze spatial patterns on a computer
screen is one thing; printing out a map for other people to look at is quite
another. ArcMap thinks of these as distinct functions and makes available a
series of tools for designing map layouts that you don’t need until you are
ready to print.

Click on the “Frame” tab. From here you can choose a different style or color
frame (to get rid of it altogether, choose “no color” from the color selector).
You can also change the background color and add a shadow (to add a
shadow, you’ll need to change the X and Y offset to something other than 0).
To make your map larger
or smaller on the page, you

Layout View

can use the zoom tools on

When you open ArcMap, you are in “Data View” and use the Tools toolbar to

the Tools toolbar or on the

navigate your map. When you switch to the Layout View, you have access to

Layout toolbar. The Layout

a different range of tools and use the Layout toolbar to navigate. To switch to

toolbar also includes a pan

“Layout View,” click on the icon at the bottom of your map display that looks

tool that you can use to

like a piece of paper (next to the globe icon) or, from the View menu, go to

move your whole layout. To

Layout View.

move just your map (and
not the whole page), use
the pan tool in the Tools
toolbar. The fixed zoom tools
in the Layout toolbar work

In Layout View, you get a much better idea of how your map will look when

like the ones on the Tools

it’s printed. ArcMap will automatically place a border (“neat line”) around

toolbar. The “Zoom to whole page” button is especially useful. One of the

your map. You can remove this by right clicking on the border (so the line is

biggest differences in Layout View is that many more options in the “Insert”

turquoise and perforated) and going to “Properties.”

menu become active. These
options allow you to add
elements—including a title,
legend, north arrow, scale
bar, and image—to your
layout. Each of these will
be separate objects in your
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layout that can be moved and resized through their Properties. You won’t see

or other obvious features that don’t need to be included in the legend. To

any of them if you switch back to Data View since they are meant to clarify

remove a layer from the legend, click on its name on the right side of this first

printed maps, not help you interpret your map on screen (in fact, the layout

screen and click on the “<” button. The order your layers are listed under

view is probably more confusing to look at from the screen because it adds

“Legend Items” will correspond to the order in which they appear in your

so many elements and usually shrinks your map). You can add text in the

legend. To change the order, click on the name and hit the up or down arrows

Layout View, but you are better off trying to label features from the Data View,

(don’t worry; this won’t affect the order in which they are drawn).

using the label or text tools.

If you want more than one column in your legend, make the adjustment here.

Working with Grids and Rulers

To see what your legend will look like (before working your way through the
rest of the screens), click the “Preview” button. If you are satisfied with it,

You can bring up a number of options aimed at helping you to place the

you can click the Finish button and skip the other steps. Otherwise, click the

objects within your layout by right clicking in your layout outside of the neat

“Preview” button again and click “Next.” On the second screen of the Legend

lines. From “Options,” you can specify ruler units and turn on and off rulers
and grids when the “Layout Options” tab is highlighted. Choosing to “snap”
to the grid or rulers will help you to line up objects, but it will also limit your
ability to make fine-level adjustments.

Adding a Title
To add a title, from the Insert menu go to “Title.” Type your title in the text box
and hit the enter key or click the cursor outside the text box. Double click on
the title to bring up the Properties where you can make changes to the text
and formatting.

Adding a Legend
Unless your labels are able to fully explain your map features, you will want
a legend on your layout. ArcMap gives you great flexibility in formatting your
legend, and all the choices can be overwhelming. To add a legend, from the
Insert menu go to “Legend.” Your first choice is what map layers you want
included. ArcView will guess that you want to include all active layers. This
may not be the case if you have layers such as a county boundary, rivers,
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Wizard, you can give your legend a title or leave the word “Legend” as the

should become highlighted, allowing you to make changes. You can also

title (or just leave it blank). The third screen allows you to create a frame and

change the map label names from the “Layer Properties” dialog box, from

shadow around your legend (not necessary, but depending upon your layout

the “General” tab.

it may be helpful, particularly if you gave your layout a background color). On
the fourth screen, you can change the symbols and symbol size used to rep-

You may also need to translate some of the values that appear in your

resent lines and polygons in your layout. On the final screen, you can make

legend. For example, you may choose to symbolize a parcel shapefile with

adjustments to the spacing between items in your legend. Click “Finish.” To

two different colors for the codes “1000” and “9999” which represent streets

make changes after you have created your legend, double click on it to bring

and sidewalks, respectively. From the “Symbology” tab, type in “street” and

up Properties.

“sidewalk” under the Labels. Be careful not to change the numbers listed

Cleaning up your map legend
Chances are that you’ll need to clean up your legend at this point. Some of
your map layer names may have underscores or other cryptic notations. The
legend will use the same names that appear in the table of contents. You can
change the label names in the table of contents without changing the name
of the shapefiles on your computer. From the table of contents, click once
on the map layer name, then click again (but not quickly). The label name
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under “Value” because this will change your map. For maps symbolized
using graduate colors, you may also want to make adjustments using the
“Label” section of the “Symbology” tab. For income, be sure to add $ and
commas.

For percentages, click on the word “Label” in the “Symbology” tab and
choose “format labels.” Select “percentage” from the right. If your number
looks like a decimal (0.15 for 15%), choose the second radio button and
click on “Numeric option.” Here you can change the number of decimals (in
most cases, you can use 1 or no digits after the decimal place. Including too
many makes your map confusing and deceiving, since your data is not that
precise).
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Adding a North Arrow

this is set, you can choose any display units you want. To add your scale

You may decide that a north arrow is not necessary (unless you choose

bar, from the Insert menu, go to “Scale bar.” Click on a style and hit “OK.”

to rotate your map so that north is no longer towards the top of the page;

Your scale bar should appear on your map. You can move or resize it by

in that case, it is definitely necessary). If you do wish to add a north arrow,

clicking on it. Double click to bring up the Properties, where you can change

from the Insert menu go to “North Arrow.” Choose a style from the “North

the number of divisions and as well as the font size (by clicking the Symbol

Arrow Selector” (preferably
something simple, and small).
You can move it around on your

button or from the format tab). You can also change the division units, from
feet to miles or km, here. If your units read “unknown units,” you will need to
define your map projection before proceeding.

layout by clicking on it. Double

No

Yes

click to change the size or style.

Adding Scale Text

Consider a small north arrow and

You may wish to include a text de-

one that is discreet.

scription of the map scale, particularly if this is important to your audience

Adding a Scale Bar

and you deliberately chose a scale

To add a scale bar, you must

(as opposed to maximizing the size

identify the appropriate units for

of your map based on the size of

your map. You can set these from

your page). To add scale text, from

the Data View or Layout View.

the Insert menu go to “Scale Text.”

From Layout View, right click in

Double click on the scale text in your

the layout (anywhere inside the

layout to bring up the Properties,

neat lines), go to Properties, and

where you can make changes to the

make the General tab active.

format and units.

From the map units dropdown
menu, choose the units used for
the original map projection (see
“Working with Projections”). Once
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Rotating a Map
You can rotate your map to better fit the page or to make it easier to read
(just because you can do this doesn’t mean it’s a good idea). If you do this,
make sure that you have a north arrow on your map. As you rotate your map,
your north arrow will adjust to indicate which direction is north. From the View
menu, go to Toolbars (or just right click on a gray part of the GUI) and Data
Frame Tools. Click on the “Rotate Data Frame” button, then click and hold
down on your map, moving your map to change the rotation. To restore the
original orientation, click on the “Clear Rotation” button.

Multiple-map Layouts
You may need to create a printed map that includes more than one map,
either because you can’t fit everything (such as Alaska and Hawaii) on your
main map, you want to show a series of small multiples (same map with
different variables), or because you want to zoom into a small area for your
main map and indicate on a smaller overview map what area the larger map
covers.

Adding Group Layers
Most of the time you will only need one data frame in a map document.
Working with data frames can make your map document complicated and
prone to crash. But if you need to include more than one map in your layout
(including the same map at a different extent), you’ll need two or more data
frames. When you open ArcMap, you’ll just have one data frame (called
“Layer”) and every map layer
you add to your map document
becomes part of this frame. To
create a second data frame,
from the Insert Menu go to
“Add Group Layer.”
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To add new data to a particular data frame, right click on its name and go to

Creating Inset Maps

“Add Data” or highlight its name and use the Add Data button (or, from the

If you want to have an overview map that shows on a larger map the outline

Insert menu, go to “Add Data”). If you want to move a layer to a different data

of the area your detailed map includes, you’ll need to create an extant rect-

frame once it is in ArcMap, right click on it and go to “Copy.” Then right click

angle. To do this, follow the instructions above to create two map layers: a

on the name of the data frame where you want to move it and go to “Paste

detail layer and an overview layer.

Layer.” The layers in only one data frame can be displayed in the map view at
a given time. It does not matter

Zoom in on your detail layer in the map view and resize it in the layout view

which one is listed first in the

so that it looks the way you want. Then right click on the overview layer in

table of contents; it matters

your table of contents. From “Properties” click on the “Extent Rectangle” tab.

which one is active. To display

Move your detail layer from the left to the right side. Click on the “Frame”

the layers in a data frame, right

button to make changes to the outline of your box.

click on its name and go to
“Activate.”
When you switch to the layout
view, you will see that there are
two map images, one for each
data frame. You will likely need
to resize and move these to fit
together.
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Exporting Maps
If you just need paper copies of your maps, you will probably have the best
results printing them from ArcView. But if you need to insert maps into Power
Point or word processing files, will need to export your maps.

Exporting Process
You can export a map from ArcMap when you are in Data View or Layout
View. However, if you want your exported map to include titles, legends, scale
bars, north arrows, and anything else you added to the layout, you’ll want to
export from Layout View. From the File menu, go to “Export Map.” There are
many options for export formats in the “Save as type” drop downmenu.
.PDF: The .pdf format allows you to open the map directly (without inserting
it into PowerPoint or MS Word) as long as you have Acrobat Reader. This is
probably the best option if you need to send someone a map or post a map
on the Internet.
.JPG: The .jpg format will compromise the quality of your image, so be sure
to click on the “options’ button when you export and increase the resolution
to at least 200 dpi (300 dpi will be as good as you need for most things). The
.jpg format is good because it stores your map in a fairly small file.
.TIF and .EPS: The .tif and .eps formats work well if you are going to open
your maps in a graphics software package, but they result in larger files.
Screen Capture: If all else fails, you can take a screen capture (push the
print screen button or alt + print screen buttons, then choose “paste”) and
crop the image, but this will not result in a presentation-quality map.
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Inserting Maps into Power Point
Save your map as an .jpg. With Power Point open, go to the Insert menu,
“Picture,” and “from file,” then Navigate to you map image and click “Insert.”
You may notice that there is a lot of white space around your map. Eliminate
this using the crop tool. You must have the map image active (click on it so
that you see small squares at the corners). Click on the crop tool and crop
the image by clicking on one of the small boxes and dragging the cursor
(if you do this without having the crop tool active, you will shrink the whole
image).
You are probably better off creating map titles in Power Point rather than
ArcView. Also, if you are making a map specifically for Power Point, consider
making the legend larger than usual (14 points or more) so that your
audience can read it.

Inserting Maps into Microsoft Word
Follow the same procedures for inserting a map into Microsoft Word. You
may have less flexibility in moving the map around than in PowerPoint, but
you should be able to crop and resize it.
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4 | Modifying Attributes
Working with Tables
Attribute Tables for Shapefiles
Every shapefile has an attribute table associated with it. You can open the
table by right clicking on the shapefile name and going to “open attribute
table.” The table will have as many rows, or records, as it does map features.
The total number of records will be shown at the bottom of your table. There
can be any number of columns (fields). Two columns are standard: FID, the
feature ID, and Shape, which can be point, polyline, or polygon. The rest
of the fields will vary. In most cases, there will also be a column that identifies each map feature with a unique name, such as a census tract number
or neighborhood name. There may be additional fields identifying attributes

Other Attribute Tables
Often you will have attribute data in a table separate from your shapefile.
For example, you may have a census tract shapefile with no attribute information and a table with all of the 2000 census tract data. ArcMap can read
Excel (.xls), dBase (.dbf), comma-delimited (.txt or .csv) and tab-delimited
(.tab) text tables but will only allow editing for .dbf tables (you can convert .txt
tables to .dbf in EXCEL, SPSS, ACCESS, or in ArcMap). You can add attribute tables to ArcMap just as you do shapefiles, using the “add data” button
or, from the file menu, “Add Data.” When you add a table, ArcMap will switch
the table of contents from the “display” to “source” tab. You can only see
tables listed when the “source” tab is active.

of the map feature (type of crime at a particular address, number of people
living in a census tract).

Open the table by right clicking on its name in the table of contents and
going to “open.” Your table should have at least one column that contains
geographic information. This might be a street address, X and Y coordinates,
census tract number, zip code, or other identifier that will allow you to match
the information in your attribute table to map features in a shapefile. You can
work with tables—sort values, freeze columns, generate summary statistics,
select records, and export tables—without worrying about corrupting your
data. You cannot change any of the data in your table unless you go to “start
editing” from the editor toolbar… except to add new fields or delete existing
fields.
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Sorting Records

Selecting Records

You can sort values in an attribute table by right clicking on the field name

You can select a subset of your records to look at more closely in a number

and going to “sort ascending” or “sort descending.”

of different ways. You can highlight an individual record (row) by clicking in
the gray area at the far left side of the table. To highlight multiple records,
hold the control key down. At the bottom of the table, ArcMap will indicate
how many of the total records are highlighted. Click on the “Selected” button
to view only the selected records. You can switch the selection, so that all
of the highlighted records become un-highlighted and all un-highlighted
records become highlighted. From the options menu, choose “Switch Selection.” You can also select all records or clear selection from the options
menu.

Freezing Columns
Freeze a column (meaning that it will remain in view even as you scroll) by
right clicking on the field name and going to “Freeze/Unfreeze Column.”

Summary Statistics
You can bring up summary statistics for any numeric field (numeric fields will
be justified right) by right clicking on the field name and choosing “Statistics.”
You can obtain summary statistics on additional fields from the drop down
menu.
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Exporting Tables
You may need to export your table from ArcMap, because you have made
changes, need to convert a .txt table to .dbf, or for any other reason. With
your table open, go to the options menu and “Export.” If you have some
records highlighted, you can choose to export just the selected records or all
of the records.

Calculating Values in Tables
You may find it easier to edit your attribute tables outside of ArcView, but
ArcView has fairly sophisticated tools for calculating values. In ArcView, you
can edit values in an existing field or create a new field and calculate new
values. Keep in mind that you cannot change the format (text, integer, long
integer) of an existing column, so if you need to transform the format of a
column, you will need to create a new field.

Creating a New Field
To create a new field, open your table in ArcMap (you can also add fields
from ArcCatalog). This can be a free-standing table or one that is associated
with a map layer, but only .dbf tables can be edited. Click on the “options”
button (if you do not see the options button, make your table bigger; it’s in
the lower right corner). Go to “Add Field.” If this option is grayed out, you do
not have permission to edit the table. Most likely, this is because the “read
only” box is checked in the table properties. This may happen automatically

Delete Field
You can delete a field by right clicking on its name and going to “Delete
Field.” ArcMap will give you a warning that the deletion is permanent and not
reversible. Do this with caution. Changes will be permanent not just within
your map document, but in your original file on your hard drive, as well.

when you copy data off a cd. To change this, find your table on your harddrive (through Windows Explorer or My Computer, not through ArcCatalog),
right click, and go to “properties.” Remove the check mark next to “read
only.”
From “Add Field,” give your field a name. Do not use ?,&,$,#,@,*,!,~
or spaces and keep your field name to 10 or fewer characters. From the
dropdown menu, choose the type of field. Different field types allow different
types of values:
Short integer: numeric, no decimal place, up to 19 characters
Long integer: numeric, no decimal place, up to 19 characters
Float: numeric, with decimal place, (default is one place before
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decimal and 11 after) Double: numeric, with decimal place
(default is 7 places before the decimal and 11 after)
Text: numbers or letters, specify length (default = 50 characters)
Date: can include time and date
Depending upon the field, you may

field name with the total 65

need to specific the scale (number

and up, click on the “/” button,

of places) and precision (number

and click on the field name

of places to the right of the decimal

with the total population. If any

point), or accept the defaults by

of the records in your table are

leaving them 0. NOTE: You can also

highlighted, ArcMap will only

add a new field from ArcToolbox

perform calculations on the

(under “Data Management Tools”,

highlighted records. You can

then “Add Field”).

also calculate values from ArcToolbox (under “Data Management Tools”, then “Calculate

Calculating Values Outside an Edit Session

Field”).

To calculate the value of your new field (or an old field), right click on its name
and go to “Calculate Values.” ArcMap will ask you if you are sure that you
want to calculate values outside an edit session, warning that you will not be
able to undo your results. Say “yes.”
ArcMap will bring up the Field Calculator. If your value is a constant, you can
simply type the value in the box at the bottom. More likely, your new value
will be based on values in other fields, so you will need to use the calculator. You can create an expression by double clicking on the field names. For
example, to calculate the percent of the population 65 and up, click on the
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Calculating Values on Selected Records

Calculating Values Inside an Edit Session

You can get an error while calculating values for many different reasons.

When you need to calculate a new variable, the best approach is to calcu-

ArcMap will not allow you to divide by zero, so if the denominator (total

late a value outside an edit session, just described. But when you need to

population in example above) is zero for any of your records, ArcMap will not

change the value on just one or two values, you may want to try editing inside

calculate any of the values.

an edit session. Go the Edit toolbar and, from the edit menu, choose “start
editing.” You can only edit the contents of one directory at a time in an edit
session, so you need to identify the directory that contains the table you wish
to edit.
Open your table and
double-click on the
value in your table you
wish to edit. When
you are finished, go to

To get around this problem, you need to select only the records where the

“stop editing” in the edit

denominator is something other than zero. Start by selecting the records with

toolbar and say “yes” to

a zero in the denominator (because there are fewer of these). Do this by right

saving edits.

clicking the field with your denominator and sorting ascending. Hold down
the control key and highlight all the records with a zero. From the options
menu, choose “Switch Selection” so that all of the records with non-zero
values are highlighted. Now you should be able to proceed with calculating
values.

Finding & Replacing Values
You can find and replace values in a table systematically from the options
menu. In order to replace values, you must be have started an edit session
(from the edit toolbar, go to “start editing”).
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Calculating Area, Perimeter & Length

Choose the polygon layer for which you want to calculate area, then deter-

Calculating Area

will be added automatically to the table of contents when ArcView is done

Usually there will be a field called “area” in a shapefile when you receive
it that indicates the area of each polygon map feature. If your shapefile

mine a name and location for the new shapefile you will create. The new layer
calculating the area. The units will be what is used by the projection system
for that map layer.

is missing this field or if you have edited the shape and size of the map
features, you will need to calculate area, yourself. Area can be especially
helpful when you are trying to normalize values and create densities (calculating persons per square mile, for example).
You can calculate area through ArcToolbox or through the Field Calculator,
but it is easier using ArcToolbox. “Calculate Area” can be found in the Spatial
Statistics Tools section, under “Utilities.”

4 |

m o d ifyi n g

attributes

63

You can also calculate are using the Field Calculator. First, open the at-

Calculating Perimeter

tribute table associated with your polygon shapefile (right click on the name

As with area, you may inherit polygon shapefiles with a perimeter field. If not,

in the table of contents and go to “Open Attribute Table”). From the options

or if you need to recalculate it, proceed as you would to calculate area. You

menu, go to “Add Field.” Call your field “Area” or “New_Area” if a field called

will need to use the Field Calculator to calculate perimeter. Open the attribute

“Area” already exists. Choose “double” as the style and click “ok.” Right

table, click on “Options” and go to “Add Field.” Create a field called “Perime-

click on your new field and go to “Field Calculator.” Check “Advanced” and

ter,” choose “double” for the style, and click “OK.” Right click on the heading

type the following in the first text box:

of your new column and go to “Field Calculator.” Check “Advanced” and type
the following into the first text box:

Dim dblArea as double
Dim pArea as IArea
Set pArea = [shape]
dblArea = pArea.area
Type “dblArea” in the next box and click “OK”.
You can copy and paste this script directly from the ArcView help (or from this

Dim dblPerimeter as double
Dim pCurve as ICurve
Set pCurve = [shape]
dblPerimeter = pCurve.Length
Type “dblPerimeter” in the second text box and click “OK.”

manual). From the ArcView help menu, click on the “search” tab and type

Calculating Length

“making field calculations.”

You may also need to calculate, or recalculate, the length
of the line segments that
make up a line shapefile (such
as streets or railroad tracks).
Open the attribute table, click
on “Options” and go to “Add
Field.” Create a field called
“Length,” choose “double” for
the style, and click “OK.”
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Right click on the heading of your new column and go to “Field Calculator.”

Changing Units

Check “Advanced” and type the following into the first text box:

ArcMap will calculate area based on the map units used for the projection in
which the shapefile is stored. For unprojected data, this is decimal degrees

Dim dblLength as double

(not particularly helpful for understanding area). For projected shapefiles, the

Dim pCurve as Icurve

most common map units are meters and feet. If you are not sure what units

Set pCurve = [shape]

ArcMap is using, check the spatial reference properties. From ArcCatalog,

dblLength = pCurve.Length

right click on the shapefile name and go to “Properties.” With the “Fields” tab
active, click on the field name “Shape” and then click on the “…” next to the

Type “dblLength” in the second text

“Spatial Reference” at the bottom of the Field Properties. Look for the unit

box and click “OK.”

listed next to “Linear Unit.”
Most likely, your data will be in projections using feet or meters as the map
unit. To convert feet to miles (for perimeter and length), divide the area by
5,280. To convert meters to miles, divide by 1,609.344. To convert square
feet to square miles, divide the area by (5,280*5,280) = 27,878,400. To
convert square meters to square miles, divide by (1,609.344 *1,609.344) =
2,589,988.110336. For more on conversions, visit
http://www.onlineconversion.com/length.htm or
http://www.translatum.gr/converter/measurements.htm.
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Creating XY Coordinates
Adding XY Coordinates to a Point Layer
Just as you may need to convert a table with XY data into a map layer, you
may need to add XY coordinates to an existing layer containing points. The
easiest way to do this is by using “Add XY Coordinates” in ArcToolbox (under
“Data Management Tools” go to “Features” to fine “Add XY Coordinates”).
Simply choose the point layer you want to assign XY coordinates and click
“OK.” The coordinates will be in whatever units are defined by your projection
(often feet or meters).

You can check the new XY coordinates by mapping them. With you table
open, click on “Options,” and go to “Export.” Say “yes” and add the new
table to your existing map, then close the table. From the tools menu, go to
“Add XY Data” and select your table from the drop down menu (ArcMap will
probably have done this for you already). Click “ok.” Your table of contents
should now show two identical point layers.
You can also add XY coordinates through the new X and Y columns and
using a Visual Basic script to calculating the X and Y values (coordinates).
With your attribute table open, go to options, add new field called “X,” type
“Double.”
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Right click at the top of your new

The script for calculating XY coordinates can be found in ArcGIS Desktop

column and go to “Field Calculator…”

Help by clicking on the “search” tab, the typing “making field calculations.”

Check “Advanced” and type the follow-

Accessing the script this way will allow you to copy and paste the script.

ing in the first box (that says “Pre-logic
VBA Script Code”):
Dim dblX As Double
Dim pPoint As IPoint
Set pPoint = [Shape]
dblX = pPoint.X
Then type “dblX” in the smaller text box (that says “X =”) in the text box
directly under the X field name. Click “ok.” Follow the same steps to create
and calculate a Y field, changing the Xs in the VB script to Y.
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Adding XY Centroid Coordinates to Polygon Layer
Adding the X and Y coordinates of the centroids of polygons is similar to
adding X and Y coordinates to a point layer. With your attribute table open,
go to options, add new field called “X,” type “Double.” Right click at the top
of your new column and go to “Calculate Values…” Check “Advanced” and
type the following in the first box (that says “Pre-logic VBA Script Code”):
Dim dblX As Double
Dim pArea As IArea
Set pArea = [Shape]
dblX = pArea.Centroid.X
Then type “dblX” in the smaller text box (that says “X =”) in the text box
directly under the X field name. Click “ok.” Follow the same steps to create
and calculate a Y field, changing the Xs in the VB script to Y.
You can check the new XY coordinates by mapping them. With you table
open, click on “Options,” and go to “Export.” Say “yes” and add the new
table to your existing map, then close the table. From the tools menu, go to
“Add XY Data” and select your table from the drop down menu (ArcMap will
probably have done this for you already). Click “ok.” Your table of contents
should now show a new point layer that represents the centroid of your
polygon layer.
The script for calculating XY centroids can be found in ArcGIS Desktop Help
by clicking on the “search” tab, the typing “making field calculations.” Accessing the script this way will allow you to copy and paste the script.
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Joining Tables
You can link map features to their attributes in GIS but only when your attributes are in the same file as your geographic data. Often you will have
attributes stored in a separate table that you will need to join to a shapefile
in order to symbolize your map with the data. You might think of a shapefile
as a series of containers that can hold attribute data. Often you will obtain
shapefiles that have no attribute data—in effect, empty containers. This is
especially common with census data, when you will often obtain shapefiles
for census tracts and blockgroups in separate files from the census attribute
data (SF1 or SF3).

Identifying a key
In order to join an attribute table to a shapefile, you will need to identify a field
that is common to your attribute table and the attribute table associated with
your shapefile. This field is known as a key, or unique identifier, because it

To make sure that both columns are formatted the same way, look and see
how they are justified. Left justified columns are formatted as text; right justified columns are formatted as numbers.

uniquely identifies each record in your table and shapefile on which ArcView
can join, or match, your data. The values must be formatted in an identical
way. If they are not, you must edit one of the fields or create a new field and
recalculate the values so that they match perfectly.
Tables with census data may contain multiple fields that uniquely identify
each record that may have names such as “TRT2000,” “STFID,” and
“TRACTID.” The field name doesn’t have to be the same in the attribute table
and the shapefile in order to join them; they just have to be formatted in the
same way. While you may perform joins on census data most frequently,
you can join attributes to shapefiles for other data: zipcodes, councilmanic

Joining a table
To join attribute data to a shapefile, you must add the shapefile to ArcMap.
Right click on its name in the table of contents, go to “Joins and Relates,”
and then “Join…”. Choose “Join attributes from a table” in the first dropdown
menu. In the second dropdown menu, identify the key you’ll use in your
shapefile. Next, choose the table you wish to join (this does not need to be
added to ArcMap). Finally, identify the key in this table. Keep in mind that
ArcView is not checking to make sure that these keys match, so you should
double-check them (by opening both tables) before performing the join.

districts, counties. You can join on a name (such as neighborhood name, or
the name of an institution), although keep in mind that differences in spelling
and spacing will keep records from joining.
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From “Advanced,” you can indicate what you

The join holding the data together is not permanent, so if you add the

want ArcView to do if all of the map features

shapefile to another map document, you will not have the appended data.

in the shapefile don’t have a match in the

To make the join permanent, right click on the shapefile name, go to “Data,”

attribute table, or vice versa. The default is

and choose “Export Data…” This works like a “save as,” so it creates a new

to keep all records, meaning that some map

shapefile. Give your new file a name (do not accept the default, “Export_

features might have no values for some fields.

Output.shp”) and location. The resulting shapefile will have variable names

Individual records might not match because

that are much shorter than those in the table created during the temporary

of problems with the key or because there are

join.

different numbers of records in each of your
files. When you open your shapefile, there
should be new fields that contain the data
from your attribute table. The new field names will include the name of the
attribute table from which it came.
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Adding Hyperlinks

You should now see a lightning bolt button in your Tools toolbar (previously

Hyperlinks allow you to click on a map feature and bring up a relevant image
(or website) rather than just the attribute values stored in your attribute table.
This is of limited use because the links will only work from inside ArcGIS.
ESRI and other vendors have developed a wide range of interactive online

it would be grayed out). Click on the lightning bolt and move the cursor over
your map. When the cursor is over the map feature with the hyperlink, you
should see the path name for the image appear. Click on the map feature
and your image should appear.

map systems that provide much greater utility than hyperlinks. But for presentations using ArcGIS, this hyperlink feature can be helpful.
Click on the map feature you wish to link with the identify tool. Make sure that
the “Identify Results” table brings up information relating to the right map
layer. Right click on the text in the box on the left and go to “Add Hyperlink.”
From the “Add Hyperlinks” box, click on the folder icon and navigate to the
image you wish to link to. Click “OK” and “OK,” then close the “Identify
Results” box.

You can add multiple hyperlinks to the same map feature using this method.
To remove hyperlinks, from the “Identify Results” box, right click on the text
on the right and go to “Manage hyperlinks.” If nothing happens when you
click on the hyperlink, you probably need to set or reset the default program
for opening the image. Find the image file you were trying to link to using
My Computer or Windows Explorer, right click on it, and go to “Properties.”
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Check the program listed next to “Open with.” If none is listed, click on
“Change” and pick a program (an image program or an internet browser, for
example). Click “OK” and “OK.” To make sure the new program can open
your image file, double click on the image file. If the software program opens
and displays your image, this should also work for your hyperlink.
You can link to a website instead of an image. Click on the map feature you
wish to link with the identify tool and right click on the text in the box on the
left and go to “Add Hyperlink.”

Adding Hyperlinks through Attribute Tables
If you have more than a few hyperlinks for a map layer, it might be easier to
add them using the attribute table. Create a new text field called “Hyperlinks.”
Start an edit session (from the Edit toolbar, go to “Start editing”). Type the full
name of the image file, including the path (for example, c:/esri/maps/image.
tif) in the appropriate record. Now you need to make the hyperlink(s) active.
In ArcMap, double click on your shapefile name in the table of contents and,
from the Layer Properties dialogue, make the “Display” tab active. Put a
check mark in the Hyperlinks box and, from the dropdown menu, choose the
field that contains your hyperlinks. Now you should be able to bring up the
hyperlink using the lightning bolt button.
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5 | Creating & Aggregating Point Layers
Geocoding

Preparing Tabular Data

Geocoding refers to the process of transforming street addresses into map

In order to geocode, you need a table (.dbf, .xls, or comma-delimited .txt)

features. In order to geocode, you need to have a table with addresses and

that has a field with street addresses. If the parts of the street address—

a shapefile for streets that matches the geographic extent of your addresses.

house number, street direction, street name, and designation/ type—are in

Through the geocoding process, ArcMap will create a new point shapefile by

separate fields, you will need to collapse these into a single field. Having a

matching each street name and number in your table to a place along a line

separate field with the zip code can also be helpful (keep this separate). In-

segment in your streets shapefile that represents a certain range of house

tersections can be used (Lehigh Avenue & N Broad Street) but house ranges

numbers. The image here shows how each section of a street centerline file

(123-127 N Broad Street) and PO boxes will not, so make sure you change

has a known street name (ST_NAME) and address range (L_F_ADD and

these to addresses with a single house number before you try to geocode.

R_F_ADD). ArcView uses this information to locate the addresses in your
table (called Foodsite_addresses here).

Creating an Address Locator
In addition to a table with addresses, you also need a shapefile that includes
information about all of the streets in your area. A street centerline file is
made up of line segments that represent certain ranges of house numbers.
The line segments also contain information about which side has even and
odd house numbers. Street centerline files are available for each county in
the United States through the US Census. You can download these for free
from the following site:
http://arcdata.esri.com/data/tiger2000/tiger_download.cfm
The street centerline file will be listed as “Line Features—Roads.” If you use
these files, you will only be able to geocode addresses for one county at a
time. ESRI also sells a product called ArcGIS StreetMap that allows you to
geocode addresses for the entire country.
In order to be able to use the county street centerline file for geocoding, you
need to create an address locator from it. This is essentially a registration
process in which you help ArcView to recognize the fields in the street centerline file so that it can prepare it for geocoding. From ArcToolbox, choose
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“Create Address Locator” (under “Geocoding Tools”).
First, you need to identify the address style from the drop-down. “US Streets”
is the most basic and only requires that you have complete street addresses,
including house number, direction, street name, and designation (Rd, St,
Ave, etc.). Look through the other styles to see which matches the data you
have if your data has different or additional information. For example, if you
have zip codes in addition to street addresses you can use “US Streets
with Zone.” The more fields that you have to help you geocode, the more
accurate your mapping will be, but the trade-off for this greater accuracy is
often a lower match rate.
The “Reference Data” refers to your street centerline file. Click in the white
space under “Role” and select “Primary
table” from the dropdown menu. At
this point, the Field Names and Alias
names in the space below should fill
in. If they do not, click on the empty
space under “Alias” and show ArcView
the name of the appropriate field. Click
“OK” to finish.
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Geocoding Addresses

The “Geocoding Options” allow you to indicate the level of sensitivity for the

You can geocode addresses through ArcToolbox, but it is easier to go to the

matching process. Essentially, ArcView needs to match the house numbers

Tools menu, select “Geocoding” and “Geocoding Addresses.” In the “Add

and street names in your tabular data with information in the streets shape-

Address Locator” screen, click on “Add” and navigate to where you saved

file. If the spelling of the street name is slightly different or an appropriate

your address locator (this will likely be in the same folder where your street

range of house numbers cannot be located, ArcView will assign the match

centerline file is located). Click “Add,” then click “OK.” On the next screen,

a less than perfect score (100 is a perfect match). ArcView can geocode

you need to identify the table with your addresses, the field that contains the

based on street intersections in addition to specific house numbers. In the

street address, and a name and location for the new point shapefile that will

“Intersections” section you can identify symbols (or “AND”) used in your

be created.

tabular data to indicate intersections. The “Side Offset” option allows you to
place points slightly away from the middle of the street centerline file. While
ArcView will know what side of the street your address falls on, your points
will appear to fall directly on the centerline unless you specify an offset. 15-20
feet is adequate. Under “Output Fields,” if you check “X and Y coordinates,”
ArcView will add X and Y fields to the point shapefile with your addresses.
Once you click “OK,” a new
address locator should be listed
under “Address Locators” in the
Catalog. Once you have created
an address locator, you don’t need
to do it again (unless you go to a
new computer).
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Click “OK” to exit the “Geocoding Options” and then “OK” again to start the
automatic geocoding process. After a few seconds (longer if you have thousands of records), ArcView will give you a report showing how many matches
were made.
Take a look at the records that
did not match by clicking on
“Match Interactively” while the
radio button under “Rematch
Criteria” is next to “Unmatched
addresses.” You may be able to
see errors in your addresses that
you can correct by going through
them one at a time. The problem
may be that you have a series of
addresses (210-220 South 34th
Street), are missing a space (725

Click on the “close” button when you have corrected all the addresses that

E.Westmoreland Street) or a mis-spelled street name. You can correct the

you are able, then click “Done.” You should see a new point shapefile in your

address by clicking on the “Modify” button or simply making the change in

table of contents. If you open the attribute table associated with the new

the “Street or intersection” box. Click “Enter” to see if new candidates appear

shapefile that the geocoding process created, you will see that the geocod-

below. Click on the best candidate, then click on the “Match” button.

ing process added several fields to your original address table. The “Status”
field indicates whether the record was matched (M) or left unmatched (U).
The “Score” field indicates how closely the record matched the street centerline file. The “Side” field indicates on which side of the street the address was
matched. The “Arc_Street” field is the address used in the match. This will be
the same as the original address unless you edited it during the “Interactive
Review.”
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Here you have access to the “Matching Options” that were available when
you geocoded your addresses. You may wish to do this if you had a low
match rate and need to adjust the spelling sensitivity or want to match candidates that tie.

Modifying your Address Locator
You can modify the properties of your address locator after you have in ArcCatalog. Right click on the address locator and go to “properties.”
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Rematching Addresses
You can resume the “Interactive Review” even after you’ve clicked “done”

If you have only an address or two to map, you can take a shortcut. From

and stopped geocoding. You may need to look up additional information

the File menu, choose “Find” and click on the “Address” tab. Next, choose

before you can correct some addresses (such as missing “N” or “S” for

an address locator in the drop down menu. If you have not already created

street names). This From the tools menu, go to Geocoding, Review/Rematch

an address locator, you will need to do so. Next, type in the address in the

Addresses and choose from the recently geocoded files. You will need to

“Street or Intersection” box and click “Find.” ArcView will display the possible

start an edit session in order to proceed. This is not a problem as long as you

matches below, with their score. Right click on one of the addresses for

remember to go to the Edit toolbar and “stop editing” when you are finished.

mapping options. You might choose to “Flash Candidate Location(s)” to
make sure it’s mapping in the right area or “Add as Graphic(s)” if you want a

Determining an acceptable match rate

marker at the location. Keep in mind that this is only a graphic; it can easily

Aim for a match rate of at least 90 or 95 percent. Be sure to write down

be deleted or moved. You can change the size and color of the graphic, but

the match rate so that you can report it later. Often you will receive a list of

you cannot turn it on and off like map layer, and it has no attributes associ-

addresses that contains some PO Box numbers or missing data that will

ated with it.

prevent you from matching all your records. Other times your addresses will
look fine but simply won’t match the street centerline file. The most important thing to determine is if the error (the unmatched records) is random
or systematic. If you have done all that you can to gather complete and
accurate addresses, random error is acceptable and probably unavoidable.
Systematic error is not. Be sure to check for patterns in your unmatched
records (either by interactively reviewing unmatched records or, after finishing geocoding, open the attribute table and sort by “status” to review all the
“U,” unmatched records). In Philadelphia, look for problems with Roosevelt
Boulevard and numbered streets (particularly 2nd – 9th Street). There is no
guarantee that the matched records will be mapped in the right place. Do a
spot check with the “Identify” tool to make sure that records mapped somewhere that makes sense to you.

Finding an individual address
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Spatial Joins

You must have a point theme and a polygon theme in ArcMap in order to do

Tabular joins use a common unique identifier to attach an attribute table to a shapefile. Spatial joins use common geography
to append fields from one layer, or information about a layer, to
another layer. This allows you to assign the characteristics of an
area—such as a census tract or city council district—to individual houses, individuals, or events as well as to aggregate points
by areas.

this. Right click on the point theme, go to “Joins and Relates…,” and choose

Assigning Area Characteristics to Points

shapefile that will be created and click “OK.”

“Join.” In the first dropdown menu, indicate that you want to join data to that
layer based on spatial location. In the next dropdown menu, choose your
polygon layer. Next, choose the first radio button so that each point is given
all the attributes of the polygon it falls inside. If you have points outside your
polygon (for example, if you have a census tract map of Philadelphia with
points representing addresses in the city and just outside it), choose
the second radio button. Specify the name and location of the new point

Using a spatial join, you can determine into what area a point falls. For

The resulting point shape-

example, you might need to determine in what council district each public

file will have as many new

school falls in.

columns as your polygon
shapefile. This may include
only the polygon identifier
(such as the census tract
number) or the identifier and
attributes.
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how many points fall inside it.” If your points do not all fall within your
polygons (for example, you have a map of city council districts and points
representing addresses in the city and just outside it), choose the second
radio button, instead. You can then decide if you want to summarize the attributes of your points by their areas in the boxes below (for example, if your
schools attribute table included a column with the total number of children
enrolled, you could summarize that data so that you know how many children
are enrolled in schools in each council district. Choose “Sum” in a situation
like this). Finally, specify the name and location of the new area shapefile that
will be created. Click “OK.”
If you did not check any of
the boxes to summarize the
attributes of the points, your
new shapefile will have only
one new field called “count.”
This will indicate how many
points fall into each polygon.

Aggregating Points by Polygons

You will probably want to

Using a spatial join, you can also determine how many points fall in each

change the name to some-

polygon. For example, you might want to know how many schools fall in

thing that you will remember

each council district. You must have a point theme and a polygon theme in

(by creating a new field called

ArcMap in order to do this. Right click on the polygon theme, go to “Joins and

“SchoolCount,” for example,

Relates…,” and choose “Join.” In the first dropdown menu, indicate that you

and calculating it as equal to

want to join data to that layer based on spatial location. In the next dropdown

“Count”). Now you can use this

menu, choose your point layer. Next, the radio button should be set for the

count value as the basis of a

second from the top option, “Each polygon will be given a summary of the

thematic map.

numeric attributes of the points that fall inside it, and a count field showing
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You can also use the spatial join function to calculate the distance between
features in two different labels. Depending upon the type of file you start with
(right click on), the spatial join dialog box will give you different options.
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6 | Querying & Measuring
Querying by Attribute
With GIS, you can identify a subset of map features based on their attributes

“Apply,” the map features that satisfy your query will be highlighted with a
bright blue outline.

or their location. You may use queries as an intermediary step, as part of

The query shown to the left identifies all

getting to know your data, to create new values, or to answer your research

one-way streets that run south through

questions.

Philadelphia.

Select by Attribute
To start a query, from the Selection menu go to “Select by Attributes.” our
first choice is what layer in your map you wish to query (attribute queries are
limited to a single layer). In the Method drop down menu, you need to decide
whether you are building on a previous query or starting fresh. From here,
the query dialog is similar to the Field Calculator. Build an expression using
the field names and functions, connecting statements with “AND” or “OR”
as necessary. The values associated with each field will be displayed in the
text box at the far right. You can use
these or type in your own. If you
want help working through these
steps, click on the Query Wizard
button. Click “Verify” to make sure
ArcMap likes your expression. You
can import (Load) and
save expressions using the buttons
OR using Ctrl + C and Ctrl + V
with a word processing file. Note
that if the values you input are text,
rather than numbers, you need to
put single quotes around them (for
example, ‘BROAD’). When you click
82
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To review the selected records, right click on the map layer and go to “Open
Attribute Table.” Click on the Select button at the bottom to view only the
selected records. You can calculate values on an existing or new field for
only the selected records. You can also look at summary statistics for only
the selected records by right clicking on a column name and going to
“Statistics.” By looking at the statistics for the length field on the selected
southbound one-way streets, we can see that there are 3,462,432 feet (655.7
miles) of southbound one-way streets in Philadelphia.

You can perform an additional query (adding, removing, or selecting from this
selected group) or close the query dialog. The query shown here will add the
northbound one-way streets to the already highlighted southbound one-way
streets.
You could also select the subset of southTo see all of the selected records, from the Selection menu, go to “Zoom to
Selected Records.” You can create a new shapefile that only includes your

bound one-way streets that are class 1
(highways) roads.

selected map features by right clicking on its name in the Table of Contents,
going to “Data” and “Export Data.” Choose the radio button regarding
coordinate systems (you’ll probably want the default). Make sure you have
“Selected Records” chosen in the Export drop down menu. To un-select all
records, from the Selection menu choose “Clear Selected Features.”
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Querying by Location
The ability to query based on the location of map features is something
unique to GIS, and combining attribute and location queries really takes

For distance-based queries, you will be able to select your units as long as
the map units have been specified in the Data Frame properties. This query
shows which charter schools are within ¼ mile (1320 feet) of public schools.

advantage of GIS functionality.

Select by Location
To select features in a map layer based on their location, from the Selection
menu go to “Select by Location.” Your first choice involves the nature of the
selection. Are you starting from scratch or querying a subset of map features
already selected? In the next box, put a check mark next to the map layer(s)
whose features you wish to select. The drop down menu then provides
various relationships between the features in that layer and a subsequent
layer (identified in the next drop down menu).

Combining Attribute and Location Queries
The “Select by Attribute” and “Select by Location” dialogs do not allow you
to mix the type of query. But by performing one type of query first and then
conducting a subsequent query on the selected records, you can perform attribute and location queries on the same map layer. For example, you may be
interested in which schools are located within 500 feet of class 1 (highways)
streets. Using the “Select by Attribute” dialog, identify all the code 1 streets
first, then select the schools “within a distance” of 500 feet of the selected
streets.
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Using Query Results
The turquoise highlight feature is meant to help you visualize relationships,
but it is not meant for final maps. Once you have identified a subset of
records, create a new variable and symbolize it properly using the symbology tab. For example, if you want to create a map showing the schools that
are located within 500 feet of highways, complete the query and then use the
query results to create a dummy variable indicating which schools meet the
query definition. Do this by opening the attribute table for the schools. Create
a new variable called “Class1500” (for 500 feet within class 1 street) that is
formatted as an integer. Right click on the new column, then go to “Field
Calculator.” Set Class1500 = 1. Only the highlighted records will be assigned
this value. Assign the other records = 0 by going to “switch selection” from
the “option” button on the bottom of the table.

As the resulting map shows, several of the public schools in Northeast Philadelphia are within 500 feet of I-95.
Often, it will not matter which query you do first. Just be sure that the selection method you choose for the second query allows you to add, remove,
or select from the records selected from the first query. You may need to try
the query a couple of times to get it right. Double-check your results to make
sure they make sense because it is easy to make a small mistake in building
your query that can leave you with a completely wrong answer.
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Measuring Distances

Measuring with Attribute Data
If you need more accurate measures of distance than you can get using the

Using the Measure Tool

measure tool, you can use the values in perimeter (polygons) and length

The measure tool allows you to draw a line, or a series of connected lines, to

(line) fields of the shapefile attribute tables. Select the features of interest,
then right click on the perimeter or

roughly measure the Euclidean (as the crow flies) distance between points.
Click on it and then click on your map at the starting point. Move your cursor

length field and go to “Summary.”

to your end point, or next point, repeating until you are done. Double click to

The “sum” field will indicate the total
distance. For example, if you need to

finish.

know the total length of Broad and
Market Streets, go to “Select by At-

The measure tool will use the map

tributes” and select all line segments

units particular to that map layers

in the street centerline file called

projection or the display units you

“BROAD” or “MARKET.” Then open

specified in the Data Frame Proper-

the attribute table associated with

ties. You can change this from the

the street centerline file, right click

Data Frame Properties (right click

on the “length” column heading, and

on the name of the Data Frame, go

go to “Summary.” The “sum” should

to Properties, and the General tab)

indicate how long Broad and Market

or in the Measure pop-up box. The

Streets are.

black triangle pointing down includes
various distance units to choose from.
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Measuring Distance with Networks
Both of these methods described above allow you to calculate Euclidean
distance—as the crow flies. This is a rather crude measure that fails to take
into consider that people can’t fly and must navigate one-way streets, traffic
conjestion, and other barriers. Using ArcView’s Network Analyst, it is possible
to factor in travel times and traffic patterns, among other considerations.

Buffers
Buffers allow you to visualize zones around map features. If you are interested in seeing which schools fall within 500 feet of class 1 (highways), you
can create a 500 foot buffer around class 1 streets. For analysis purposes,
queries by location may be more helpful because they will allow you to
actually select the schools within 500 feet of class 1 roads. But you may want
to create buffers, as well, so that you can visualize this relationship.
You can create buffers using the Buffer tool in ArcToolbox (under Analysis
Tools). Select the map layer you wish to buffer using the first dropdown
menu. Note that ArcView will only buffer highlighted features if any of them
are highlighted. Specify a name and location for the new buffer shapefile,
then specify the distance and distance units. You may want to choose
“all” from the “dissolve” dropdown so that the buffer around multiple map
features, such as street segments, will be one continuous polygon.
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Multiple Ring Buffers
If you want to show several different distances at the same time, choose the
“Multiple Ring Buffers” Tool in ArcToolbox (under Analysis Tools). Choose
the layer you wish to buffer and specify a name and location for the new file.
Type in each distance, one at a time, and click the + key so that the distance
appears in the list below.
Use the symbology options in Map Layer Properties to represent the different
rings with different colors.
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7 | Creating New Geographic Files
Editing Shapefiles

From the Target drop down menu in the Editor toolbar, indicate which map

Editing shapefiles is tricky—and a bit dangerous—territory. If possible, use
the geoprocessing tools such as clip, union, intersect, and dissolve to make
changes to your shapefiles rather than using the editing tools described
below. The directions provided here are very minimal. If you need to do much
editing of shapefiles, you should seek out additional resources (such as the

layer you wish to edit. To edit an existing feature (point, line, or polygon), click
on the edit tool and click on the feature you wish to edit (it should become
highlighted). By clicking and holding down the mouse button, you can move
your map feature to a new location. To modify a line or polygon feature,
double click on it. Notice that the vertices become visible and the Task menu

ESRI Virtual Campus course on digitizing).

automatically brings up “Modify a Feature.” You can reshape your feature

Deleting and Modifying Features

of the map feature to complete. (ArcView will show the last created vertex in

by putting your cursor over a vertex, clicking, and dragging it. Click outside

In order to make changes to a shapefile, you must start an edit session. From
the Editor toolbar, choose “start editing.” If you have multiple shapefiles in
your map document that are from different subdirectories on your computer,
you will need to specify which directory will be part of the edit session (you
can only edit the files in a single folder at one time).

red). You can add a vertex to a feature by right clicking on a green line and
going to “insert vertex” (a new vertex will be created where you right click).
Most of the boundaries between polygons are shared boundaries. In order to
move the boundary for both polygons (rather than creating an awkward gap),
you need to use the shared edit tool. Click on the shared edit tool and double
click anywhere on the shared boundary. The shared boundary will be shown
in green and the vertices along the shared boundary will become visible.
Move a vertex, then click outside the map feature to complete.
To save edits, from the
Editor menu on the
Editor toolbar, choose
“Stop Editing” and say
“yes” to saving edits.
Notice that you do
not have a “save as”
option. You may want to
make a backup of your
original data before
editing.
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Merging Features

Splitting Features

In order to dissolve the boundaries between two or more polygon features,

Splitting polygon features involves creating a new line within an existing

you must start an edit session. Using the edit tool and the shift key, click on

polygon. Start an edit session and choose “Cut Polygon Features” from the

the features you wish to merge (they should become highlighted), then from

Task drop down menu. Using the edit tool, select the polygon you wish to

the Editor menu on the Editor toolbar select “Merge.” You can also select

split. Click on the sketch tool and then draw a line through your polygon (the

map features based on their attributes by opening the attribute table and

line does NOT have to be straight), double clicking to complete. To save

selecting the corresponding records. To save edits, from the Editor menu on

edits, from the Editor menu on the Editor toolbar, choose

the Editor toolbar, choose “Stop Editing” and say “yes” to saving edits.

“Stop Editing” and say “yes” to saving edits.

Updating Area, Length, and Perimeter
Keep in mind also that editing shapefiles can change attribute values that
you may need to update. Follow the directions in the section of this guide
entitled “Calculating Area.”
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Transforming Shapefiles
There are a number of different functions you can perform on map layers,
either based on location or attribute value, that result in new map layers.
Several of them fall under the description of “overlay analysis.” You must
define the projection for map layers before using any of these functions. If
you have selected a subset of features within a map layer, the functions will
only be performed on the selected features.

Dissolve
The dissolve operation allows you to collapse the boundaries between
polygons if they share the same value on a particular attribute. For example,
you could create a neighborhood map layer by assigning each census tract
to a neighborhood and then dissolving the boundaries. From ArcToolbox,
you can find “Dissolve” under “Data Management Tools” and “Generalization.” On the next screen, you need to identify the map layer whose features
you wish to dissolve under “input features.” If the layer is already added

ArcView will create a new shapefile that combines all of the map features

to ArcMap, you can use the dropdown menu. Otherwise you will need to

(census tracts) into a single polygon (neighborhood).

click on the folder icon to locate the may layer. ArcMap will give the new
shapefile that will be created a default name (adding “_Dissolve” to the
input layer name). If you want to rename this or change the location, click on
the folder to the right of “input feature class.” Next, choose the column in
from that layer’s attribute table that contains the information you wish to use
for the dissolve. This must be an attribute for which multiple map features
(polygons) have the exact same value. The values can be numbers or text,
although keep in mind that nominal and categorical variables will work better
than ratio variables. If polygons have the same value but are not contiguous,
they will still be dissolved into a “multipart feature.”
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merge. You can use the dropdown menu if you have added the map layers
to ArcMap, but you will need to add them one at a time. A new layer will not
automatically be created, so you will need to specify an EXISTING layer in
“output feature.” This will overwrite the existing layer, so be sure to make
a backup copy if necessary. If the columns in the attribute tables of all the
input features are identical, you can select “TEST” under “Scheme Type.”
Otherwise, you must choose “NO_TEST.” The resulting shapefile will contain
all of the map features in the appended layers. If the column names were the
same for all of the layers (as they could be for census tract files from different
counties), there will be values for each record in each column. Keep in mind
that these merged shapefiles can grow very large, particularly if you merge
street centerline files.

Append
Appending allows you to incorporate two or more non-overlapping layers
into a single map layer without changing their map features. You can append
point, line, and polygon layers. Appending can save you time when it comes
to symbolizing features and lead to more consistent symbology. For example,
you can merge census tract files from several counties so that when you
display the percent of homeowners, you don’t have to repeat the process of
classifying your data for each county.
From ArcToolbox, you can find “Append” under “Data Management Tools”
and “General.” Under “input features,” list all the map layers you wish to
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Clip

Intersect

Clipping allows you to turn one shapefile into a cookie-cutter in order to

Intersect allows you to fuse two overlapping layers together to create a new

cut out part of a larger shapefile. For example, you might need to create a

shapefile that includes the attributes of both layers for the area in which the

map layer of streets for the area within a single police district but your street

layers overlap. In effect, this combines the union (described below) and clip

centerline file covers the entire city. Using a street file that is clipped by the

operations. You can intersect two polygon layers or a line and polygon layer.

police district boundaries will allow you to work with a smaller and more

From ArcToolbox, you can find the “Intersect” function under “Analysis Tools”

manageable file that looks neater. From ArcToolbox, you can find “clip” under

and “Overlay.” On the next screen, select the input features. The default

“Analysis Tools” and “Extract.” On the next screen, you need to identify an

name for the new shapefile will be the first input feature name plus “_Inter-

input feature (the layer to be clipped) and the clip features (cookie cutter).

sect.” If you want to change this or the location of the new file, click on the

The default name for the new shapefile will be the input feature name plus

folder to the right. If you intersect a line and polygon layers, the resulting

“_Clip.” If you want to change this or the location of the new file, click on the

shapefile will contain “polylines” that act like lines. If you intersect polygon

folder to the right. You can leave “Cluster Tolerance’ at 0. Changing it will

layers, the resulting shapefile will contain polygons. Length, perimeter, and

allow slightly mismatched map layers to be considered “coincident.”

area values will be inaccurate after you perform an intersection, so if you
need these be sure to recalculate them. Other attribute values maybe deceptive, as well. In the example at right, census tracts were intersected with
police districts. The result was many sliver polygons resulting from slight differences in their digital boundaries, not real differences in their actual boundaries. Note that three polygons have been given the same total population
based on the census tract data, two of which are sliver polygons. Adjusting
the cluster tolerance can help you avoid sliver polygons.
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Union
Union is similar to intersection in that it fuses the boundaries of two layers
together, but rather than clipping the resulting shapefile to include only the
area covered by both, it creates a new shapefile that covers the combined
extent of the layers. From ArcToolbox, you can find the “Union” function
under “Analysis Tools” and “Overlay.” Select the input features. The default
name for the new shapefile will be the first input feature name plus “_Union.”
If you want to change this or the location of the new file, click
on the folder to the right. As with shapefiles created through intersections, the
shapefiles created by a union will most likely have some attribute values that
no longer make sense. Be sure to recalculate length, perimeter, and area if
you need these variables.
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8 | Digitizing
Most of the time you will use shapefiles that someone else created. Using
existing shapefiles saves time and generally results in more accurate map
layers. But if you need a line or polygon file that doesn’t exist—such as a
boundary for your study area—you will need to create it yourself. Digitizing is
the process of drawing or tracing map features to create a new geographic
file. Before on-screen digitizing was available, this process involved tracing
a paper map on a digitizing tablet and then assigning real world coordinates
to certain parts (like georectifying). In some cases, professionals will still use
this approach. But ArcView 9.2 has on-screen digitizing tools that allow you
to create new shapefiles without additional hardware or software.

Creating New Shapefiles
When you open ArcMap, you are in “Data View” and use the Tools toolbar to
navigate your map. When you switch to the Layout View, you have access to
a different range of tools and use
the Layout toolbar to navigate.
To switch to “Layout View,” click
on the icon at the bottom of your

Next, open ArcMap and add your new shapefile, along with other map layers

map display that looks

that may help you draw your new features. Start an edit session: from the

like a piece of paper (next to the

Editor menu in the Editor toolbar, choose “Start Edit Session,” and indicate

globe icon) or, from the View

which directory contains the shapefile (shell) you just created. Be sure that

menu, go to Layout View.

your new shapefile is listed as the Target and that “Create New Features” is
selected from the Task menu. Next, you need to choose a drawing tool. You
have five choices: The Create New Feature tool allows you to draw points,
lines, or polygons. The Arc tool allows you to create lines that are curved
(rather than just a bunch of short line segments that look like a curve). The
Distance-Distance tool will place a point at one of the locations where two
circles intersect. The Intersection tool places a point where two lines would
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cross if they continued far enough. The Trace tool creates features that follow

Snapping to an Existing Feature

existing map features.

It is nearly impossible to draw features that match an existing layer just by
looking at it. The result is map layers that look sloppy and can negatively

The Create New Features tool is the most basic and allows you to draw new

impact the result of your analyses. You can avoid this problem by “snapping”

map features. Click to create a new vertex and double click to finish. In the

your new lines to an existing shapefile. From the Editor menu of the Editor

example at left, a new polygon feature was drawn that follows four streets.

toolbar, go to Start Editing and indicate which directory contains the shape-

Use the delete tool to start over. Use the undo tool to remove the last vertex.

file (shell) to which you want to add map features. From the Editor menu,

To save your new feature, from the Editor menu choose “Stop Editing” and

choose “Snapping.” In the top of the dialog box, you can identify the layer(s)

save edits.

to which you want to snap your new features. Try drawing your new features
using different combinations of layers and vertices and/or edges. If you use a
street centerline file as your guide, vertices will work well. Now when you start
to draw your new features using the Create New Features tool, your cursor
will be pulled toward the vertices of the shapefile you are trying to trace.
To create the most accurate line, move your cursor slowly over the existing
shapefile, clicking at each vertex to create a new vertex in your shapefile. You
can change the snapping “tolerance”—the distance from the existing shapefile you can be and still snap to it—from the Editor menu, “Options,” and the
“General” tab. The map units reflect the units you identified in the Data Frame
properties (General tab).
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Digitizing using the Merge Tool
The tools in ArcMap for dissolving boundaries between features provide
another approach to digitizing. This may give you less control over the shape
of new map features, but it provides an easier way of creating new shapefiles
that line up with existing shapefiles. In order to create shapefiles using the
dissolve tools, you need to have a shapefile that can serve as building blocks
for your new file. For example, you may want to create a map of health districts. If the districts are based on census tracts, you can use a shapefile of
census tracts to build your new district file. A census block file may prove the
most helpful. To start, add a census block layer to ArcMap. Select the blocks
within the area of interest, create a new shapefile based on these selected
blocks (right click on it, go to “Data” and “Export Data”), and add it to your
map.

Using the snapping tool, you should be able to create new features that
line up with existing shapefiles, even when you zoom in close. If you are not
happy with your results, click on the map feature with the Edit tool and hit
Delete (you can do this even after saving edits to the shapefile, as long as
you start an Edit Session).
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Using the Select Features tool, highlight the blocks that cover just the area

If your new shapefile only needs to include this single map feature, you can

you want your new map layer to cover. You can select multiple features by

right click on the block shapefile (with the new feature still selected), go to

holding down the shift key. You can also draw a box around the area contain-

Data and Export Data. Be sure that the Export drop down menu indicates that

ing the individual features (this is faster). To dissolve the boundaries between

only selected features will be included. Alternatively, you may need to repeat

the blocks, start an edit session, then from the Editor menu choose “merge.”

the process of dissolving boundaries so that all census blocks become part

Stop editing and save edits to finish.

of a new map feature.
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9 | Working With 3D
3D Models of Vector Data

The navigate button is the most useful. When you hold down the right mouse

3D modeling happens in ArcScene rather than ArcMap. ArcScene is a

button, you can spin and twist your map layers, looking above or below them

separate application (.exe file) that you can launch from the Start Menu

and from any angle. If you click the left mouse button, you will be able to

(Programs, ArcGIS, then ArcScene). Once open, it looks similar to ArcMap

zoom in and out continuously. If you hold both buttons down, you can pan

with a table of contents in the left, where the names of your map layers will

your map layers (move them around without zoom in or out or tilting them).

appear, and a big space to the right where your map layers will draw. You

The zoom in/out button allows you to zoom in and out continuously (like the

add map layers into ArcScene just like ArcMap, with the “Add Data” button

continuous zoom tool in ArcMap). It is even easier in ArcScene to loose track

or from the File menu, “Add Data.” Don’t worry if your map layers look funny

of where you are than it is in ArcMap. Click on the full extent button (globe) to

when you first add them. Vector polygons layers will draw as solid fill colors

bring your map layers back. The fly tool allows you to swoop in and around

without any outlines. Points and lines will look more similar to the way they

your model (caution: this may cause motion sickness). Hit “Esc” to stop.

draw in ArcMap. It is possible to make points and lines 3D, but polygons
work better. Most of the buttons on the tools toolbar for navigating your map

In order to make your polygons 3D, double click on the map layer. Most of

layers are the same in ArcScene as ArcMap, but a few are new.

the tabs under “Layer Properties” are the same as ArcMap, but some are
new. Click on the “Extrusion” tab. Here you can enter a constant value under
“Extrusion Value or Expression” in order to make the entire layer the same
height. This makes sense in some situations, such as when extruding streets
and sidewalks in an impervious surface layer.
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More often, you will want to extrude the polygons based on an attribute.
For example, if you have a height variable, you can extrude the polygons to
reflect this. Click on the little calculator to the right of the “Extrusion value or
expression” box and use the “Expression Builder” to create a formula for the
height of the building. You may need to adjust the formula later to make your
relative heights work, but don’t worry too much at this point. Click “OK” and
then click “OK” again. Now your buildings should be different heights. You
can use attributes other than height or elevation as the basis of the extrusion.
For example, you can extrude neighborhoods based on the amount of crime.
In order to see the differences in the height more clearly, use the options
under the Symbology tab (use this just the way you do in ArcMap) to make
different heights different colors (graduated color map based on height
variable). You can use different variables for the basis of your extrusion and
symbology, especially when you are extruding based on height or elevation.
For example, you can use the extrusion option to make buildings different
heights and then use the symbology options to use different colors to show
which properties are vacant.
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Scene Properties

3D Models for Raster Data

To access scene properties, double click on the word “Scene Properties” at

Raster data makes for great 3D models in ArcScene. Add your raster layer

the top of your table of contents or go to the View menu and “Scene Proper-

to ArcScene just as you do vector layers. If you are asked about building

ties.” From the General tab, you can change the background color (black

pyramids, say “yes.” Don’t worry if your map layer looks funny when you

looks pretty cool). You can also change the vertical exaggeration. This is

add it. From the “Layer Properties” click on the “Base Heights” tab. Click the

especially helpful when your layers look too flat or way too tall after extru-

radio button next to “obtain heights for layer from surface.” This means that

sion. Click on “calculate extent” for ArcScene’s suggestion for how much you

the values stored in your raster layer will be used as the basis for the layer’s

should exaggerate the vertical extent. If you put a check mark in the “Enable

height. Then from the “Symbology” tab, switch to a classified map and sym-

Animated Rotation” box, you can make your 3D scene spin around continu-

bolize your map using one of the color ramps. You may want to exclude all 0

ously. Rotate your scene with the navigate button, then let go of the mouse

raster values (click on classify, then exclusion and type in “0”) and add extra

button while the scene is still moving. Imagine that your scene is sitting on

classes so that the color ramp shows more gradual differences in value.

top of a lazy susan and you are just giving it a push in the right direction. Hit
“Esc” to stop the animation. From the Illumination tab, you can change the
height and direction of the sun to adjust the lighting in your 3D scene.
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You may need to exaggerate the
differences in your values to create
a 3D model. From Scene properties, go to the “general” tab and click
on “Calculate from Extent” next to
“Vertical Exaggeration.” If you do, you
may wish to report this exaggeration
factor when you create maps out of
ArcScene.

Animating 3D Scenes
To animate your 3D scene, you need the Animation Toolbar to be visible
(“View” menu to toolbars, then “Animation”). The animation will be based on
a series of snapshots of your 3D scene. Use the navigate tool to create the
first perspective. Click on the camera button once (or use “Ctrl” + “A”). Use
the navigate tool to choose your next perspective, then click on the camera.
When you have created all your images, open the animation tools (using the

Saving 3D Scenes

button at the far right of animation toolbar). Click on the play button to view

You can save your 3D scene in the same way you save a map document

your animation. You can adjust the length (from options button) and speed

in ArcMap. Instead of an .mxd file, you will create an .sxd file. Since these

(from Animation menu, Animation Manager) of your animation.

behave in the same way as .mxd files, you need to remember to keep the
.sxd file with the shapefiles or raster layers upon which the 3D scene is built.
To export an image from ArcScene as a 2D image, go to the “File menu” and
“Export scene” and “2D.” You can also save an
animation as a video file.
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10 | Troubleshooting
I can’t save my files...
Are you saving to a write-able drive (you can’t save to a cd)? If so, change

I can’t open the attribute table on my shapefile after the
join...

the location where you are trying to save the file. Have you run out of room on

Right click, data, export, save under new name, add back in. Might work.

your drive? Try deleting some old files (if you are deleting map layers, be sure

Spaces in names of variables?

to do this in ArcCatalog).

Long name? On harddrive, change name of file, try again.

My scale bar isn’t right...

I can’t add/open my table to ArcView...

Are the units “unknown”? You need to define the projection for one or more

Is it open anywhere else (like in Excel)? If so, close and re-try. Are there

of your map layers. Do the units show up but not make sense? For example,

spaces in the names of any of your variables? If so, correct this in Excel,

does it show that Center City Philadelphia is 0.5 miles tall or 30 miles wide?

re-save, and try again.

Your projection was probably defined incorrectly. Start over with your original
map layer and work through the projection steps again.

I can’t see my table in the table of contents...
At the bottom of the table of contents, click on the source tab.

My map looks skewed...
You may have skewed it here, while resizing. Export the map again. Resize

I can’t move my layers up and down in the table of
contents...

only from the corners, not the sides (resizing from the sides squishes the

At the bottom of the table of contents, click on the display tab.

Did you export the map in import it into MS Word, PowerPoint or other file?

map). Are your data projected? Check the coordinates in the bottom right of
your map in the map view. If you see longitude/latitude coordinates, that’s the

I made a change, but I don’t see it on the screen...

problem. Be sure to define, then project the data.

Refresh the graphics (arrows in a circle next to map view and layout view
buttons).

I can’t join my attribute table...
Are you starting with the shapefile? Be sure to right click on the shapefile you

I get an error message when I calculate values...

are joining your data to, then choose “join.”

Are you dividing by zero? Sort the column with your denominator to look

Have you identified an identical join field in both tables? Open both tables up.

for zeros. Highlight every row with a zero, switch the selection so that all

Sort them both ascending to descending to make sure they are the same.

non-zero rows as highlighted, then try your calculation again.

Count the number of digits. Make sure both are formatted as string (left justified) or number (right justified).

1 0 |

w o r k i n g

w i t h

3 d

103

I just get 0 and 1 when I’m trying to calculate a percent...
You probably formatted your column as a short integer rather than double.
Delete the column (right click on column name, delete) and create a new
variable formatted as double, then try your calculation again.

Still stuck?
Close ArcView, re-start and try again. Try a new computer somewhere else
(different lab). Ask for help. Don’t worry, pretty much everyone does at some
point (or at least they should).
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